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บทคัดยอ 
เขตพื้นที่อุตสาหกรรมภาคตะวันออก บริเวณพื้นที่ลุมน้ําชายฝงทะเลตะวันออกเปนพื้นที่ที่

มีความสําคัญตอระบบเศรษฐกิจของประเทศไทย เนื่องจากเปนพื้นที่ที่มีการกระจายตัวของนิคม
อุตสาหกรรมและเขตอุตสาหกรรมจํานวนมาก ทําใหพื้นที่ในบริเวณนี้มีความตองการการใชน้ําเพื่อ
รองรับการขยายตัวของภาคอุตสาหกรรม โดยแหลงน้ําที่สําคัญที่สามารถตอบสนองความตองการ
นี้ไดคือแหลงน้ําบาดาล ดังจะเห็นไดจากการปฏิบัติภารกิจของกรมทรัพยากรน้ําบาดาลในการแกไข
ปญหาภัยแลงของพื้นที่ในภาคตะวันออกในป พ.ศ. 2548 ในการศึกษานี้มีพื้นที่ศึกษาตั้งอยูบริเวณ
อําเภอศรีราชาและอําเภอบางละมุง จังหวัดชลบุรี ในการศึกษานี้มุงเนนศึกษาสมบัติของชั้นน้ํา
บาดาลโดยใชวิธีทางธรณีฟสิกส ขอมูลหลุมเจาะจากกรมทรัพยากรน้ําบาดาล ตลอดจนขอมูลสูบ
ทดสอบ เพื่อประกอบกับการสรางภาพตัดขวางและแบบจําลองเชิงมโนทัศน (Conceptual Model) 
ในพื้นที่ดังกลาวซึ่งสามารถนําไปใชประโยชนในการวางแผนการบริหารจัดการการใชน้ําบาดาล
อยางยั่งยืนตอไป เม่ือนําขอมูลตางๆมาจําแนกชั้นหินอุมน้ําตามลักษณะของตะกอนและคุณสมบัติ
ทางธรณีฟสิกสสามารถแบงชั้นน้ําในพื้นที่ศึกษาไดเปน 2 ชั้นน้ําหลักดังนี้ 1.ชั้นหินใหน้ําตะกอนเศษ
หินเชิงเขา (Colluvium Aquifers, Qcl) หรือชั้นตะกอนวางตัวอยูดานบนสุดประกอบดวยทราย ดิน
เหนียว กรวด ไมมีการแบงแยกตะกอนเปนชั้นๆเพราะชองวางระหวางเม็ดตะกอนมักจะถูกอุดตัน
ดวยชั้นดินเหนียวตกตะกอนทับอยูดวยกัน มีระดับความลึกของชั้นน้ําบาดาลประมาณ 10-40 เมตร 
2. ชั้นหินแข็งของหินแกรนิต (Granite Aquifers) วางตัวอยูชั้นลางสุด มีระดับความลึกของชั้นน้ํา
บาดาลประมาณ 40-80 เมตร โดยมีคุณสมบัติทางชลศาสตรของชั้นหินในน้ําบาดาลอันไดแก คา
สัมประสิทธิ์การจายน้ํา (Transmissivity, T) ดังนี้ ในชั้นตะกอนจะมีคาสัมประสิทธิ์การจายน้ํา
ตั้งแต 0.420 -1.070 m2/d สวนในชั้นหินแข็งจะมีคาสัมประสิทธิ์การจายน้ําตั้งแต 0.200 -1.270 
m2/d สําหรับคาสัมประสิทธิ์การยอมใหน้ําซึมผาน (Hydraulic conductivity) ในชั้นตะกอนจะมีคา
สัมประสิทธิ์การยอมใหน้ําซึมผาน 0.052 -0.268 m/d สวนในชั้นหินแข็งจะมีคาสัมประสิทธิ์การ
ยอมใหน้ําซึมผาน 0.013 -0.159 m/d และจากแบบจําลองเชิงแนวคิดของอุทกธรณีวิทยาชั้นหินอุม
น้ําทั้งชั้นตะกอนและชั้นหินแข็งมีทิศทางการไหลสวนใหญจากทิศตะวันออกไปยังทิศตะวันตก 
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Abstract 

In eastern industrial area, coastal watershed is important for the economical 
system of Thailand. In this area, there is the distribution of industrial estates that cause 
of increasing of  water demand, particular for groundwater served for huge amount of 
water usage. The study areas of this research locate in Amphoe Sriracha and Amphoe 
Banglamung, Changwat Chonburi. The objectives of this study aimed to 1) describe 
the hydrogeologic characteristics of groundwater aquifer by interpretating the 1-D 
resistivity data, borehole logging, lithologic logs and pumping test and 2) create cross 
section and conceptual model that will be applicable for groundwater resources 
management plan. As a result of data interpretation, the aquifers in this area can be 
divided into 2 types: colluvium aquifer and fractured granite aquifer. The colluvium 
aquifers, the uppermost sediment which lied over the granite aquifer and is composed 
of sand, clay and, gravel that their inter-granular pores are filled by clay. The depth of 
colluvium aquifer commonly varies from 10 to 40 meters. The depth of the granite 
aquifer varies from 40 to 80 meters. According to pumping test data analyzed by 
Theis, Cooper-Jacop, Neuman and Hantush methods, the transmissivity values ranged 
from  approximately 0.420 to1.070 m2/d and 0.200 to1.270 m2/d in colluvium aquifer 
and fractured granite aquifer, respectively. The hydraulic conductivity ranged from 
approximately 0.052 to 0.268 m/d and 0.013 to 0.159 m/d in colluvium aquifer and 
fractured granite aquifer, respectively. Finally, the conceptual models of colluvium 
aquifers and granite aquifers showed there charge/discharge system and groundwater 
direction genrally moves from eastern recharge area toward western discharge area. 
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ขอมูลการหยั่งธรณีฟสิกสในหลุมเจาะ 

ขอขอบคุณบริษัทจีเอ็มทีคอรเปอเรชั่นที่ชวยอนุเคราะหขอมูลทั้งขอมูลการสํารวจธรณี
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ขอขอบคุณเพื่อนๆธรณีวิทยารุนที่ 52 ทุกคน ที่คอยใหความชวยเหลือและคอยใหกําลังใจ 
และทายที่สุดนี้ขอขอบคุณครอบครัวของดิฉันที่อยูเคียงขางดิฉันตลอดมา 
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บทท่ี 1 
บทนํา 

1.1 ท่ีมา ปญหา และความสําคัญของงานวิจัย 
 เขตพื้นที่อุตสาหกรรมภาคตะวันออก บริเวณพื้นที่ลุมน้ําชายฝงทะเลตะวันออกเปนพื้นที่ที่
มีความสําคัญตอระบบเศรษฐกิจของประเทศไทย เนื่องจากเปนพื้นที่ที่มีการกระจายตัวของนิคม
อุตสาหกรรมและเขตอุตสาหกรรมจํานวนมาก ทําใหพื้นที่ในบริเวณนี้มีความตองการการใชน้ําเพื่อ
รองรับการขยายตัวของภาคอุตสาหกรรม โดยแหลงน้ําที่สําคัญที่สามารถตอบสนองความตองการ
นี้ไดคือแหลงน้ําบาดาล ดังจะเห็นไดจากการปฏิบัติภารกิจของกรมทรัพยากรน้ําบาดาลในการแกไข
ปญหาภัยแลงของพื้นที่ในภาคตะวันออกในป พ.ศ. 2548 

น้ําบาดาลเปนทรัพยากรธรรมชาติที่สําคัญมากตอมนุษยและส่ิงมีชีวิต โดยเฉพาะปจจุบัน
มีการพัฒนาน้ําบาดาลข้ึนมาใชประโยชนกันอยางแพรหลายเนื่องมาจากน้ําผิวดินมีปริมาณไม
เพียงพอตอความตองการ ซึ่งการพัฒนาเพื่อนําน้ําบาดาลข้ึนมาใชหากทําในลักษณะที่ไมถูกตอง 
จะทําใหระดับน้ําบาดาลลดลงอยางมากและไมสมดุลกับการเพิ่มเติมของน้ําบาดาลตามธรรมชาติ 
กอใหเกิดผลกระทบตอปริมาณเก็บกักของแองน้ําบาดาลในอนาคต ดังนั้นจึงควรที่จะรูลักษณะของ
แหลงน้ําบาดาลเพื่อที่จะไดมีขอมูลที่ถูกตองเพื่อนําไปประยุกตใชตอไป น้ําบาดาลมีลักษณะเดนคือ
มีอุณหภูมิและคุณภาพที่คอนขางคงที่ ไมคอยแปรผันตามฤดูกาล และมีการลงทุนตอปริมาณน้ําที่
ดีต่ํากวาน้ําผิวดิน ดังนั้นควรใชน้ําบาดาลใหเกิดประโยชนสูงสุดและปองกันคุณภาพของน้ําบาดาล
ไปพรอมกัน     

ลักษณะอุทกธรณี วิทยาของจังห วัดชลบุ รีเปนชั้นหินกักเก็บน้ําประเภทหินแข็ง 
(consolidated rock) ประมาณรอยละ 65 ของพื้นที่ทั้งหมด พื้นที่สวนที่เหลือประมาณรอยละ 35 
เปนชั้นหินกักเก็บน้ําประเภทชั้นตะกอน (unconsolidated rock) ปริมาณน้ําจะสามารถกักเก็บได
มากนอยเพียงใดข้ึนอยูกับขนาดของชองวางที่มีอยูในเนื้อหินและความตอเนื่องของชองวางที่น้ําฝน
หรือน้ําผิวดินไหลซึมลงไปเก็บกักอยูได หินแข็งที่ไมคอยมีรอยแตกรอยราวจะเปนบริเวณที่หาน้ําได
ยากมากตั้งแตจังหวัดชลบุรีจนถึงจังหวัดระยอง และจันทบุรี และจะมีคุณภาพน้ําที่เปนน้ํากรอย 
สวนบอบาดาลที่เจาะในรอยแตกรอยราวของหินแกรนิตจะใหน้ําจืดและเปนน้ําที่มีคุณภาพดี  

ในการศึกษานี้มีพื้นที่ศึกษาตั้งอยูบริเวณอําเภอศรีราชาและอําเภอบางละมุง โดย
การศึกษานี้มุงเนนศึกษาสมบัติของชั้นน้ําบาดาลโดยใชวิธีทางธรณีฟสิกส ขอมูลหลุมเจาะจากกรม
ทรัพยากรน้ําบาดาล ตลอดจนขอมูลสูบทดสอบ เพื่อประกอบกับการสรางภาพตัดขวางและ
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แบบจําลองเชิงมโนทัศน (Conceptual Model) ในพื้นที่ดังกลาวซึ่งนําไปใชในการวางแผนการ
บริหารจัดการการใชน้ําบาดาลอยางยั่งยืนตอไป  
1.2 วัตถุประสงคของงานวิจัย 

1.2.1 เพื่อศึกษาลักษณะทางอุทกธรณีวิทยาและสมบัติการกักเก็บน้ําของชั้นน้ําบาดาลใน
บริเวณอําเภอศรีราชาและอําเภอบางละมุง จังหวัดชลบุรี   

1.2.2 เพื่อสรางแบบจําลองเชิงมโนทัศน ของชั้นน้ําบาดาลในบริเวณอําเภอศรีราชาและ
อําเภอบางละมุง จังหวัดชลบุรี   
1.3 ขอบเขตงานวิจัย  

 ใชขอมูลที่รวบรวมจาก 
 - การสํารวจธรณีฟสิกสบนผิวดินดวยวิธีการวัดความตานทานไฟฟาแบบแนวดิ่ง ขอมูล
หลุมเจาะในพื้นที่ศึกษามาชวยในการแปลความหมายเพื่อหาลักษณะของชั้นน้ําในบริเวณพื้นที่
ศึกษา  
 - ขอมูลการสูบทดสอบน้ําในระยะยาว (72 ชั่วโมง) เพื่อหาสมบัติทางชลศาสตรของชั้นหิน
ใหน้ํา   
1.4 ผลท่ีคาดวาจะไดรับ  

1.4.1 อธิบายลักษณะทางอุทกธรณีวิทยาและสมบัติการกักเก็บน้ําของชั้นน้ําบาดาลใน
บริเวณอําเภอศรีราชาและอําเภอบางละมุง จังหวัดชลบุรี   

1.4.2 สรางแบบจําลองเชิงมโนทัศนและแสดงทิศทางการไหลของน้ําของชั้นน้ําบาดาลใน
บริเวณอําเภอศรีราชาและอําเภอบางละมุง จังหวัดชลบุรี   
1.5 พื้นท่ีศึกษา  

  พื้นที่ศึกษาตั้งอยูบริเวณอําเภอศรีราชาและอําเภอบางละมุง จังหวัดชลบุรี รูปที่ 1.1 อยูใน
แองน้ําบาดาลยอยซึ่งอยูบริเวณตอนกลางของแองน้ําชลบุรี เปนที่ตั้งของนิคมอุตสาหกรรม เขต
ประกอบการอุตสาหกรรม โรงงานอุตสาหกรรม และสถานที่กําจัดขยะมูลฝอย ครอบคลุมพื้นที่
ประมาณ 270 ตารางกิโลเมตร มีอาณาเขตดังนี้ 
  ทิศเหนือ ติดกับ  อ.เมืองชลบุรี 
  ทิศใต  ติดกับ  อ.สัตหีบ 
  ทิศตะวันออก ติดกับ  อ.ปลวกแดง 
  ทิศตะวันตก ติดกับ  อาวไทย    
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คําอธิบาย 
     ขอมูลช้ันดินช้ันหิน 
 
 

ขอมูลระดับน้ําในช้ันตะกอน 
 
 

ขอมูลระดับน้ําในช้ันหินแข็ง 
 
 

ขอมูลการสูบทดสอบปริมาณน้ํา 
 

ขอมูลการหยั่งธรณีฟสิกสใน
หลุมเจาะ 

 

ขอมูลธรณีฟสิกส 
 จังหวัด 

 

อําเภอ 
 

พื้นท่ีสํารวจศึกษา 
 

ขอบเขตอําเภอ 
 

ขอบเขตจังหวัด 

รูปท่ี 1.1 แผนที่แสดงบริเวณพื้นที่ศึกษาตั้งอยูบริเวณอําเภอศรีราชาและอําเภอบางละมุง จังหวัดชลบุรี 
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บทท่ี 2 
เอกสาร งานวิจัยและทฤษฎีท่ีเกี่ยวของ 

2.1 เอกสารและงานวิจัยท่ีเกี่ยวของ 
 1. พรเลิศ (2010) ศึกษาเร่ืองลักษณะทางอุทกธรณีวิทยาของชั้นน้ําบาดาลในบริเวณ
อําเภอพรานกระตาย จังหวัดกําแพงเพชร โดยใชขอมูลการสํารวจธรณีฟสิกสบนผิวดินดวยวิธีการ
วัดความตานทานไฟฟาแบบแนวดิ่ง และใชขอมูลหลุมเจาะในพื้นที่ศึกษามาชวยในการแปล
ความหมายเพื่อหาลักษณะของชั้นน้ําในบริเวณพื้นที่ศึกษา ทําการสูบทดสอบปริมาณน้ําทั้งใน
ระยะส้ัน (12 ชั่วโมง) และระยะยาว (72 ชั่วโมง) เพื่อหาสมบัติทางชลศาสตรของชั้นหินใหน้ํา นํา
ขอมูลระดับน้ําในบอมาสรางแผนที่แสดงทิศทางการไหลของน้ําบาดาลในแตละชั้นน้ํา นอกจากนี้
ยังนําขอมูลผลวิเคราะหเคมีในน้ําบาดาลมาวิเคราะหหาลักษณะอุทกธรณีของชั้นน้ําบาดาล ผล
การศึกษาสรุปวา                                                                                                             

I. ในพื้นที่ศึกษาบริเวณอําเภอพรานกระตาย มีชั้นหินอุมน้ําอยู 3 ชั้นหลักๆ ประกอบไป   
ดวย 1.ชั้นหินอุมน้ําตะกอนตะพักน้ํายุคใหม (Qyt) 2.ชั้นหินอุมน้ําตะกอนตะพักน้ํายุคเกา 
(Qot) 3.ชั้นหินอุมน้ําในชั้นหินแข็ง (หินตะกอนกึ่งแปรสภาพ, SDmm) โดยมีสมบัติทางชล
ศาสตรของชั้นหินอุมน้ําพบวาชั้นน้ําที่มีศักยภาพใหน้ําบาดาลมากที่สุด คือ ชั้นหินอุมน้ํา
ในชั้นหินแข็ง (หินตะกอนกึ่งแปรสภาพ, SDmm) เนื่องจากมีคาสัมประสิทธิ์การจายน้ํา 
(Transmissivity, T) ที่สูง 

II. จากผลดานอุทกเคมีพบวาลักษณะของรูปแบบทางเคมีของน้ําบาดาลในพื้นที่เปนแบบ 
Calcium-Sodium Bicarbonate type หรือ Sodium-Calcium Bicarbonate type เปน
สวนใหญทําใหทราบวาในพื้นที่ศึกษา น้ําบาดาลจะคอนขางมีความกระดางอยู ซึ่งเปน
ผลจากในบริเวณพื้นที่ศึกษาอาจจะมีพวกหินที่มีสวนประกอบเปนพวกแคลเซียม
คารบอเนตอยูบริเวณใกลเคียง และถาจะนําน้ํามาใชบริโภคจะตองมีการปรับปรุง
คุณภาพเพื่อลดความกระดางลง 

  III. จากแบบจําลองเชิงแนวคิดเชิงอุทกธรณีวิทยา (Conceptual model) พบวาชั้นหินอุมน้ํา
ทุกชั้นมีทิศทางการไหลสวนใหญ (Intermediate flow system) ไปในทิศทาง
ตะวันออกเฉียงเหนือจะพบบางในบางบริเวณที่มีทิศทางการไหลที่แตกตางกัน ทําใหพบ
ลักษณะของกรวยน้ําลด (Cone of depression) ในแผนที่แสดงทิศทางการไหลอัน
เนื่องมาจากการสูบน้ําข้ึนมาใช 
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  2. Baranwal และ Sharma (2005) ไดศึกษาขอมูลเกี่ยวกับรอยแตกของชั้นใหน้ําในหิน
โดยใชคล่ืนแมเหล็กไฟฟาความถี่ต่ํา (very low frequency electromagnetic, VLF) และคาการ
ตานทานไฟฟา (resistivity) ที่เมือง Purulia ทางดานตะวันตกของอาว Bengal ประเทศอินเดีย โดย
การใชขอมูลจาก VLF เพื่อหาพื้นที่ศักยภาพทางน้ําบาดาลซึ่งผลการสํารวจพบวา ทางดานเหนือ
ของพื้นที่มีรอยแตกระดับในตื้นและไมกวางมากนักเนื่องจากคา VLF แสดงคาผิดปกติในระดับวง
แคบสวนทางดานใตนั้นคา VLF แสดงคาผิดปกติในระดับไพศาล จึงทําใหม่ันใจไดวาควร
ทําการศึกษาบริเวณพื้นที่ทางใต โดยสํารวจดวยคาการตานทานไฟฟา ผลจากการสํารวจพบวา
พื้นที่ทางใตนั้นพบคาการตานทานไฟฟาในระดับต่ําจึงสรุปไดวาทางดานใตนั้นนาจะมีน้ําใตดินไหล
ผานที่บริเวณนี้ 

3. Chandra และคณะ (2010) ศึกษาเร่ืองแบบจําลองธรณีฟสิกสของชั้นหินแกรนิตใหน้ําที่
ไมตอเนื่องโดยวิธีการวัดคาความตานทานไฟฟาในพื้นที่ขนาดยอม ขอมูลที่ไดจาก electrical 
resistivity tomography (ERT) สามารถแยกชั้นหินแกรนิตไดหลายลักษณะ เชน หินแกรนิตที่ยังไม
ถูกกระบวนการแปลสภาพ หรือหินแกรนิตที่ผานการแปลสภาพมาแลว และหินแกรนิตที่มีการแปล
สภาพซ้ําซอน จากนั้นคัดเลือกและแบงพื้นที่เพื่อใชคาความตานทานไฟฟาในการสํารวจข้ันตอน
ตอไป โดยที่คาความตานทานไฟฟาที่ไดจะมีชวงที่สามารถบงบอกไดถึงสภาวะแวดลอมของชั้น
หินแกรนิตบริเวณนั้นๆได แตเนื่องจากขอมูลดังกลาวไมสามารถนําไปเทียบสัมพันธกับหินแกรนิตที่
อ่ืนไดทําใหขอมูลที่ไดมีการจํากัดการใชขอมูลเฉพาะแหง ผลสรุปจากขอมูลขางตนไดผลวาสายแร
ควอตซนั้นมีคาเหมาะสมที่จะใหเปนแหลงชั้นน้ําบาดาลในหินแกรนิตบริเวณนี้ 

4. Edet และ Okereke (2002) ศึกษาการแปลความหมายน้ําบาดาลระดับตื้นบริเวณทราย
ที่ราบชายฝง พื้นที่คาลาบาประเทศไนจีเรีย (Calabar area southern Nigeria) โดยใชขอมูลคา
ความตานทานไฟฟาและขอมูลทางอุทกธรณีวิทยา (hydrogeological data) จากผลการสํารวจทํา
ใหสามารถแยกชั้นขอมูลออกมาได โดยใชการบูรณาการขอมูลที่ไดจากหลุมเจาะเทียบสัมพันธกับ
ขอมูลคาความตานทานไฟฟาทําใหทราบชวงของคาความตานทานไฟฟาวาชวงคาความตานทาน
ไฟฟาที่ไดมานั้นเปนหนวยใด เพื่อใชในกรณีที่แนวการแบงชั้นน้ําบาดาล ทั้งนี้หลังจากแบงชั้นน้ํา
บาดาลแลวจึงทําการทดลองหาคาสัมประสิทธการซึมผานของน้ําบาดาลในแตละหนวยเพื่อเก็บ
ขอมูลและแบงชวงคาของสัมประสิทธการซึมผานเพื่อแสดงใหเห็นวาบอน้ําบาดาลนั้นๆ มีคาสัมประ
สิทธการซึมผานในแตละหนวยมีคาเทาไหร 

5. Lee Cheng-Chao และคณะ (2008) ศึกษาขอมูลสภาพแวดลอมทางอุทกธรณีวิทยา
พื้นที่ Lishan landslide ประเทศใตหวัน โดยใชขอมูลคาความตานทานไฟฟา (image resistivity 
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profile) และขอมูลหลุมเจาะ (bore hole data) เพื่อใชในการสรางโมเดลใตผืนดิน (subsurface) 
ทําใหมองเห็นการวางตัวของชั้นหินเพื่อคาดเดาทิศทางการไหลของน้ํา จากผลการสํารวจทําให
สามารถแยกชั้นขอมูลออกมาไดเปน 3 หนวยคือ หนวยคือ บริเวณเศษหินตะกอนเชิงเขาและรอย
แตกของหินชนวน (colluviam and fracture of slate A) บริเวณรอยเฉือน (shear zone B) และ
หินชนวน (slate C) โดยใชการบูรณาการขอมูลที่ไดจากหลุมเจาะเทียบสัมพันธกับขอมูลคาความ
ตานทานไฟฟาทําใหทราบชวงของคาความตานทานไฟฟาวาชวงคาความไฟฟาที่ไดมานั้นเปน
หนวยใด เพื่อใชในกรณีที่แนวการสํารวจคาความตานทานไฟฟาดังกลาวไมมีขอมูลหลุมเจาะ
เทียบเคียงก็สามารถใชขอมูลจากบริเวณขางเคียงมาแปลผลได 

6. Stefan และ Vitaly (2005) ศึกษาเร่ืองอิทธิผลของความแตกตางของชั้นน้ําและผลการ
แปลความหมายของคาการไหลคืนจากผลการทดลองสูบ (return flow pumping test) โดยใช
ระดับน้ําลดเทียบกับเวลา (time-drawdown) และคาสมมติฐานการระบายน้ําฉับพลัน 
(assumption instantaneous drainage) เพื่อนํามาสรางกราฟหาคาการไหลผานของน้ําบริเวณ
นั้นๆ จากผลการทดลอง สามารถสรุปไดวาผลกระทบจากการไหลกลับของชั้นน้ําสงผลกับระยะน้ํา
ลดและคาสัมประสิทธิ์การซึมผานของน้ํา (Hydraulic conductivity) นอกจากนี้ความหลากหลาย
ของชั้นน้ํา (Aquifer heterogeneity) เปนเหตุผลสําคัญที่ทําใหเกิดความแปรปรวนสูงในการ
คาดคะเนปริมาณน้ําบาดาลและคาสัมประสิทธิ์การซึมผานของน้ําในแนวตั้ง (Vertical hydraulic 
conductivity)  
2.2 ทฤษฎีท่ีเกี่ยวของ  

หลักการวัดคาความตานทานไฟฟาจําเพาะ 
  การสํารวจโดยวิธี Resistivity เปนการสํารวจอีกวิธีหนึ่งของการสํารวจดวยวิธีการทางธรณี
ฟสิกส ในการสํารวจทางธรณีฟสิกสทุกประเภทจะไมสามารถตรวจวัดชนิดของดิน หิน หรือแรได
โดยตรงเหมือนกับการเจาะสํารวจ แตเปนการตรวจหาคาซึ่งเปนคุณสมบัติทางฟสิกส เชน หาความ
หนาแนน (Density) คาคุณสมบัติทางไฟฟา (Electrical Property) ของชั้นดิน หิน แร ที่อยูใตผิวดิน
ในบริเวณนั้น ดังนั้นการสํารวจ โดยวิธีนี้จึงมีเปาหมายเพื่อวัดคาความผันแปรของความตานทาน
กระแสไฟฟาของชั้นตะกอนใตผิวดิน ทั้งในแนวดานขาง เชน ตามแนว สํารวจ และแนวดิ่งหรือ
ความลึก แลวจึงนําผลที่ไดนี้มาแปลความหมาย (Interpretation) ใหเปนขอมูลดานธรณีวิทยา เชน 
ชนิดและโครงสรางของหิน หรือชั้นตะกอน อีกที่หนึ่ง  ในการสํารวจวัดคาในสนามจะปลอย
กระแสไฟฟา (I) ลงไปในพื้นผิวดิน โดยผานทางข้ัว Electrode 2 ข้ัว ที่วางหางกัน แลววัดคาของ
ความ ตางศักยของกระแสไฟฟา (V) จากข้ัว Electrode อีกคูหนึ่ง ดังรูปที่ 2.1 
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รูปท่ี 2.1 วงจรไฟฟาของการสํารวจดวยวิธีวัดคาความตานทานไฟฟาจําเพาะ 

ท่ีมา : http://www.nga.com/Geo_ser_DC_tech.htm  
ทฤษฎีพื้นฐานจาก Ohm's Law เม่ือกระแสไฟฟาไหลผานวัตถุตางๆจะมีความตานทานตอการไหล
ของกระแสไฟฟา ตามสมการ 
 
 
 โดยที่ 

R  คือ ความตานทาน มีหนวยเปน โอหม                                                                                                           
V   คือ คาความตางศักย มีหนวยเปน โวลท                                                                   
I คือ  คากระแสไฟฟา  มีหนวยเปน แอมแปร 

เคร่ืองมือสํารวจเก็บขอมูลในสนามสําหรับงานสํารวจ Resistivity ประกอบดวย 
   ก. แหลงกําเนิดกระแสไฟฟา ซึ่งอาจใชแบตเตอร่ีรถยนต (DC) หรือเคร่ืองปนไฟฟา (AC) ที่
มีขนาดของกําลังตั้งแต 5 วัตต ถึง หลายกิโลวัตต กระแสไฟที่ใชในการวัดคามีขนาดตั้งแต 5 มิลลิ
แอมแปร จนถึงหลายแอมแปร  
 ข. เคร่ืองวัดคาความตางศักยของกระแส หรือ โวลทมิเตอร ที่สามารถวัดคาใหรายละเอียด
สูง ซึ่งอาจเปนแบบใชเข็ม หรือตัวเลข  
 ค. ข้ัวอีเลคโตรด (Electrode) อาจจะเปน แปบน้ําโลหะ หรือ ถวยกระเบื้องเซรามิค  
 ง. อุปกรณอ่ืนๆ เชน สายไฟ สายเทปวัดระยะ วิทยุมือถือ กระปองน้ําเหลือ เปนตน 
 
 
 
 

R = V / I 
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ตารางท่ี 1.1 แสดงคาความตานทานไฟฟาของหินแตละชนิด 
Material Resisitivity 

Wet to moist clayey soil and wet clay 1s to 10s 
Wet to moist silty soil and silty clay Low 10s 
Wet to moist silty and sandy soils 10s to 100s 
Sand and gravel with layers of silt Low 1000s 
Coarse dry sand and gravel deposits High 1000s 
Well-fractured to slightly fractured rock 
with moist-soil-filled cracks 

 

100s 

Slightly fractured rock with dry, soil-filled 
cracks 

 

Low 1000s 

Massively bedded rock High 1000s 
ท่ีมา : After Burger 1992 

หลักการหยั่งธรณีฟสิกสในหลุมเจาะ 
การตรวจสอบชั้นน้ําบาดาล ดวยเคร่ืองหยั่งธรณีฟสิกสเปนการตรวจสอบชั้นน้ําบาดาลใน

หลุมเจาะ ที่ยังมิไดใสทอกรุบอ (Casing) ดวยการหยอนเคร่ืองหยั่งธรณี (Loggers) จากปากบอ
จนถึงกนบอ เพื่อตรวจสอบชัน้ดินชั้นหิน และ ชั้นน้ําบาดาล เพื่อใชเปนขอมูลการออกแบบกอสราง 
บอน้ําบาดาล (Well design) ทําใหสามารถกําหนดชวง ความลึกของทอกรอง และชวงการอุดปด
กั้นชั้นน้ําเค็ม โดยวิธีการหยั่งธรณีที่นํามาใชมี หลักการดังนี้  

1) Resistivity log เปนการวัดคาความตานทานไฟฟาของชั้นหิน โดยหลักการแลว
เคร่ืองมือจะสงกระแสไฟฟาเขาไปในชั้นหินและวัดการตอบสนองของชั้นหินที่มีตอกระแสไฟฟาที่สง
เขาไป โดยใชข้ัวไฟฟา (Electrodes ) จํานวน 4 ตัว โดยข้ัวไฟฟา 2 ตัวจะทําหนาที่เปนตัวปลอยและ
รับกระแสไฟฟา (Current electrodes) และทําการวัดคาความตางศักยไฟฟาที่ข้ัวไฟฟาอีก 2 ตัว ซึ่ง
ทําหนาที ่Potential electrodes การจัดข้ัวไฟฟาทั้ง 4 ตัวนี้จะจัดเปน 2 รูปแบบคือ Short normal 
และ Long normal ซึ่งจะมีการวางตําแหนงของข้ัวไฟฟาและระยะหางระหวางข้ัวไฟฟาที่แตกตาง
กัน การจัดรูปแบบข้ัวไฟฟาทัง้สองรูปแบบกจ็ะมีผลตอความตานทานไฟฟาจําเพาะที่อานออกมาได 
การที่ระยะหางระหวาง Current electrodes มีคามากก็จะทําใหกระแสไฟฟาผานเขาไปในชั้นหิน
รอบๆ หลุมเจาะไดลึกกวาในกรณีที่มีระยะหางไมมากนัก ดังนั้นขอมูลที่ไดจากการจัดรูปแบบ
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ข้ัวไฟฟาตางๆ ก็จะชวยเสริมกันในการแปลความหมาย Resistivity logging จะชวยในการบงบอก
ลักษณะของหิน (Lithology) ที่หลุมเจาะผานชวยแยกชั้นน้ําจืดและน้ําเค็มออกจากกัน 

2) Spontaneous (Self) Potential logging (SP log) เปนการวัดคาความแตกตางของ
ศักยไฟฟาระหวางจุดสองจุดใดๆ ในหลุมเจาะทีมี่สาเหตุจากเซลลไฟฟาเคมีที่เกิดข้ึนในธรรมชาต ิ
โดยในหลุมเจาะจะตองมีน้ําโคลนที่สามารถนําไฟฟาได (Conductive mud) SP log ไมสามารถทํา
ในหลุมเจาะที่ใชน้ําโคลนแบบน้ํามัน (Oil-base mud) หลุมเจาะที่ไมมีน้ําโคลน (Empty holes) 
หรือหลุมเจาะที่ลงทอกรุ (Case holes) สาเหตุเกิดจากในหลุมเจาะซึ่งมีน้ําโคลนที่สามารถนําไฟฟา
ไดมักมีความเขมขนของสารละลายนอยกวาน้ําที่อยูในชั้นหินเปนผลใหเกิดการไหลของ
กระแสไฟฟาระหวางชั้นหินตางๆและน้ําโคลนในหลุมเจาะทําใหเกิดคาผิดปกติข้ึนบนกราฟของ SP 
มีประโยชนในการชวยพิจารณาหาชั้นหินเนื้อพรุน หรือชั้นหินอุมน้ําซึ่งปกติจะแสดงคาศักยไฟฟา
ธรรมชาติที่มีคาสูง (คาลบ)  

3) Natural-Gamma logging เปนการวัดคากัมมันตรังภาพรังสีแกมมา (Gamma-ray) ที่
เกิดข้ึนเองตามธรรมชาติในชั้นหินซึ่งตนกําเนิดที่สําคัญไดแก ไอโซโทปของโพแทสเซียม (K) 
ยูเรเนียม (U) และทอเรียม (Th) ซึ่งจะพบมากในแรดินเหนียวในชั้นหินดินดาน (Shale, Clay) 
เพราะฉะนั้นคาที่อานไดจะสะทอนถึงปริมาณของหินดินดานหรือแรดินในชั้นหิน เนื่องจากธาตุ
กัมมันตภาพรังสีมักสะสมตัวอยูในชั้นดินเหนียวและชั้นหินดินดาน ชั้นที่ไมมีดินเหนียวปนอยูจึงมี
ระดับของกัมมันตภาพรังสีต่ํา (ยกเวนหินที่มีธาตุกัมมันตภาพรังสีเกิดรวมดวยเชน เถาภูเขาไฟ
(Volcanic ash) หินแกรนิตที่ผุพัง (Granite wash) Natural-Gamma logging มีประโยชนในการ
ชวยหาชั้นหินดินดาน บอกสัดสวนชั้นหินดินดาน ใชแยก Shale ออกจาก Non-shale นอกจากนี้ยัง
นํามาใชหาคาสัมประสิทธิ์คาความซึมได แตบางคร้ังหินทรายก็มีคา Gamma-ray สูงไดเนื่องจากมี 
Clay มาปนมากหรือมีพวกแรFeldspar มาปนมาก 

หลักการสูบทดสอบปริมาณน้ํา 
การสูบทดสอบที่เปนมาตรฐาน จําแนกได 3 วิธ ีคือ                                                                  
1. การสูบทดสอบแบบตอเนื่องระยะส้ัน (Short term pumping test)                                                                          
2. การสูบทดสอบแบบตอเนื่องระยะยาว (Long term pumping test)                                                        
3. การสูบทดสอบแบบปรับอัตราทดสอบ (Step draw down test) 

  3.1 กรณีสูบทดสอบแบบที่ 1เปนการสูบน้ําที่อัตราคงที่ เชน 50ลบ.ม/ชม. ตอเนื่อง
ไปจนระดับน้ําในบอสูบคงที่เปนระยะเวลาติดตอกันอยางนอย 1 ชั่วโมง (วัด 3คร้ัง)                                                            
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  3.2 การสูบทดสอบแบบที ่ 2  เปนการสูบน้ําในอัตราคงที่ เชน 80 ลบ.ม/ชม.
ตอเนื่องไปตามระยะเวลาที่ไดวางแผนไวแลว เชน 24 ชั่วโมง 48 ชั่วโมง 72 ชั่วโมง 7 วัน หรือ 10 
วัน เปนตน ทั้งสองแบบทดสอบจะตองวัดระดับน้ําในบอสูบและบอสังเกตการณ  เม่ือหยุดสูบตอง
วัดระดับคืนตัวจนถึงระดับปกติ หรือไมนอยกวารอยละ 90   
   3.3 กรณีสูบทดสอบแบบที่ 3 เปนการสูบทดสอบปริมาณจากบอบาดาลโดยเร่ิม
จากอัตราสูบนอยไปมาก เชน 10, 20, 30, 40 ลบ.ม/ชม.  โดยที่อัตราสูงสุดคือ 120% หรือ 150 % 
ของศักยภาพบอและอัตราต่ําสุดคือ ประมาณ 50% ของศักยภาพบอ การสูบน้ําอัตรา 120% หรือ 
150% เปนภาวะการรีดน้ําออกจากบอบาดาลและชั้นน้ําบาดาลเพื่อใหเกิดจุดเปล่ียนระหวาง 
Laminar flow และ Turbulent flow มีประโยชนตอการคํานวณหา Well lost และ Formation lost 
 นําขอมูลมาทําการวิเคราะหเพื่อคํานวณหาคุณสมบัติชลศาสตรของชั้นหินอุมนํ้าโดยใช
สูตรหรือสมการที่สอดคลองกับเงื่อนไขของการสูบทดสอบและของขอมูลที่ใชตอไป ดังนี้  

 1.การสูบทดสอบในสภาวะสมดุล (Steady state conditions) 
ในกรณีที่การสูบทดสอบดํา เนินการไปจนถึงสภาวะสมดุล กลาวคือ ระดับนํ้าจะไมลดลง

ตอไปอีกแลว สามารถทําการวิเคราะหหาคุณสมบัติทางชลศาสตรของชั้นหินอุมนํ้าตามกรณีและ
เงื่อนไขดังนี ้

1.1 กรณีชั้นหินอุมน้ํามีแรงดัน (Confined aquifer) โดยใช Theim equation ตาม
สมการ 

T =  ln       (2.1) 

 
   

1.1กรณีชั้นหินอุมน้ําไมมีแรงดัน(Unconfined aquifer) โดยใช Theim equation 
ตามสมการ 

K =  ln    (2.2) 

       
โดยมี  T    =    Aquifer transmissivity (L2/T; m2/d or ft2/d) 

K    =    Aquifer hydraulic conductivity (L/T; m/d or ft/d) 
Q    =    Constant pumping rate (L3/T; m3/d or ft3/d) 
h1       =    Head at distance r1 from the pumping well (L; m or ft) 
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h2    =    Head at distance r2 from the pumping well (L; m or ft) 
b1    =    Saturated thickness at distance r1 from the pumping well (L; m or ft) 
b2       =    Saturated thickness at distance r2 from the pumping well (L; m or ft) 

2.การสูบทดสอบในสภาวะไมสมดุล (Non-steady state or Non-equilibrium 
conditions) 
  โดยทั่วไป การสูบทดสอบเพื่อใหถึงสภาวะสมดุลอาจจะใชเวลานานมากและในหลาย ๆ 
กรณีจะไปไมถึงสภาวะสมดุล ดังนั้นการใชขอมูลการสูบทดสอบในสภาวะไมสมดุล (Non-
equilibrium หรือ Transient conditions) จึงใชประโยชนไดกวางขวางมากกวา ขอมูลที่สําคัญคือ 
Time-drawdown data จากบอสังเกตการณซึ่งสามารถนํามาวิเคราะหหาคา K, T และ S ของชั้น
หินอุมนํ้าที่เจาะผานได ในขณะที่ขอมูลจากหลุมทดสอบเองสามารถนํามาวิเคราะหหาคา K และ T 
ได แตไมสามารถหาคา S ได การวิเคราะหขอมูลการสูบทดสอบสามารถทําไดหลายวิธีดังนี ้
 2.1 ชั้นน้ําภายใตแรงดัน (Confined aquifer) 

2.1.1 Theis Method  
(1) นําคา W(U) กับ 1/u  จากตารางมาตรฐานมาเขียนลงบนกระดาษกราฟที่มี 

Logarithmic scale ซึ่งกราฟนี้จะมีรูปรางคลายกรวยนํ้าลด (Cone of depression) 
(2) นําคาระยะนํ้าลด (drawdown, h0-h) และคาเวลาหลังการสูบที่สัมพันธกัน (t, 

Time after pumping) มาเขียนลงบนกระดาษกราฟอีกแผนหนึ่ง โดยมี Logarithmic 
scaleขนาดเดียวกับ Type curve  

(3) นํากระดาษกราฟทั้งสองมาวางทาบกัน โดยใหแกนขนานกันทั้งแกนตั้งและ
แกนนอน และพยายามทําใหเสนกราฟทั้งสองทาบกันใหสนิทมากที่สุด 

  (4) บนกราฟที่ทับกันสนิทดีแลว โดยทั้งแกนตั้งและแกนนอนขนานกัน 
ตลอดเลือกจุดใดจุดหนึ่งบนเสนกราฟหรือบนกระดาษกราฟ เรียกจุดนี้วา Match point 
ลากเสนระนาบและเสนดิ่งจาก Match point ไปตัดกับแกนของกราฟทั้งสอง ซึ่งจากจุดตัด
กับแกนของกราฟทั้งสองรูปนี้จะใหคาออกมาทั้งหมด 4 คาคือ W(U), 1/u, h0-h และ t  
การเลือก Match point จะเลือกที่ตําแหนงไหนก็ได ในกรณีที่เลือก Match point ที่
ตําแหนงตัดกันของ W(U) = 1 และ 1/u = 1 จะทําใหการวิเคราะหผลสะดวกข้ึนและนําคา
ตางๆที่ไดมาคํานวณตามสมการ  

   Transmissivity     T =  W(u)   (2.3) 
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   Storativity   S =      (2.4) 
โดยมี    T  =  Aquifer transmissivity (L2/T; m2/d or ft2/d) 

S   =  Aquifer storativity (Dimensionless) 
Q  =  Constant pumping rate (L3/T; m3/d or ft3/d) 
h0-h  =  Drawdown (L; m or ft) 
W(U)   =  Well function of 4 (Dimensionless) 
T  =  Time since pumping began (T; d) 
r  =  Radial distance from the pumping well (L; m or ft) 
u  =  Dimensionless constant 

2.1.2 Cooper-Jacob Method  
(1) นําขอมูลระยะน้ําลด (Drawdown, h0-h) ไปพล็อตเทียบกับเวลาที่ทําการวัด 

(t) ในกราฟ Semi-log จะไดเปนเสนตรง โดยกราฟ Log จะเปนแกนของเวลา  
(2) ทําการเลือกระยะน้ําลด (Drawdown, h0-h) ตอ Log cycle ของเวลา (เลือก

เวลาที ่10 กับ 100 เพื่อสะดวกในการวิเคราะห) และหาคาผลตางของระยะน้ําลด และนํา
คาตางๆมาคํานวณ 

   Transmissivity     T =     (2.5) 

     
  Storativity  S =         (2.6) 

  2.1.3 Huntush inflection – Point Method 
 วิธีนี้เหมาะสําหรับชั้นหินที่มีการร่ัวซึม ใชในการหาจุด inflection สําหรับการทํา 
pumping test ที่ใช 1 observation well มีข้ันตอนดังนี ้
 (1) plot drawdown ใน log scale โดยเปน function ของเวลา ตั้งแตเร่ิมทําการ
สูบทดสอบ ถาถึงจุด equilibrium จะไดคา maximum drawdown = (h0-h)max แตถายังมี
การเกิด drawdown อยูใหทําการคํานวณคาจากกราฟเพื่อหา (h0-h)max 

 (2) drawdown ที่จุด inflection point = (h0-h)i โดย drawdown จะมีคาเทากับ 
1/2 ของ maximum drawdown = (h0-h)max 
 (3) จากกราฟที่เวลาใดๆ ti เม่ือ (h0-h)i จะสัมพันธกัน slope ของ drawdown 
curve ที่จุด inflection point = mi                      



   

 

13 
 

   (2.7) 
    

T/2rB    (2.8) 
                                                       

(2.9) 
   

โดยมี    T  =  Aquifer transmissivity (L2/T; m2/d or ft2/d) 
S  =  Aquifer storativity (Dimensionless) 
Q  =  Constant pumping rate (L3/T; m3/d or ft3/d) 
h0-h  =  Drawdown (L; m or ft) 
r  =  Radial distance from the pumping well (L; ft or m) 
b  =  Saturated thickness (L; m or ft) 
2.2 ชั้นน้ําไรแรงดัน (Unconfined aquifer) 

2.2.1 Neuman Method  
การไหล ของน้ําในชั้นหินอุมน้ําไมมีแรงดันจะสามารถอธิบายดวยสมการของ 

Neuman&Witherspoon (1969) ซึ่งสมการมีดังตอไปนี ้
 

   (2.10)   

โดยมี     h  = Saturated thickness of the aquifer (L; ft or m) 
r  =  Radial distance from the pumping well (L; ft or m) 
z  =  Elevation above the base of the aquifer (L; ft or m) 
Ss  =  Specific storage (1/L; 1/ft or 1/m) 
Kr  =  Radial hydraulic conductivity (L/t; ft/d or m/d) 
Kv  =  Vertical hydraulic conductivity (L/t; ft/d or m/d) 
t  =  Time (T; d) 
น้ําที่มาจากชั้น water table aquifer จะมาจาก 2 กระบวนการ ถาเปนชั้นหินอุมน้ํามี

แรงดันการลดลงของความดันจะเกิดในชั้น aquifer yields water เพราะวามาจากคา elastic 
storage ของ aquifer storativity (SS) การลดลงของระดับน้ํายังสัมพันธกับการที่มันลดลงภายใต
แรงโนมถวงจากตะกอนซึ่งอยูในรูปของ specific yield (Sy) สมการขางตนจะใชสําหรับ radial flow 
ในบริเวณที่มีการบีบอัด  
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จะมี 3 ชวงของ time-drawdown relations ในระดับน้ําในบอ จะทําการวัดการตอบสนอง
ของ typical annular region ของ aquifer ที่ตั้งอยูในระยะคงที่จากบอสูบทดสอบ หลังจากที่มีการ
เร่ิมสูบน้ําคาความดันใน annular region จะลดลง ที่จุดที่ความดันเร่ิมลดลง aquifer จะตอบสนอง
โดยการกระจายตัวของน้ําที่มีปริมาตรเพียงเล็กนอยซึ่งเปนผลมาจากการแผขยายของน้ําและการ
บีบอัดในชั้น aquifer ชวงระหวางนี้ aquifer จะมีพฤติกรรมเปน artesian aquifer และคาของ time-
drawdown จะแปรตาม Theis nonequilibrium curve สําหรับคา elastic storativity (S) 

การไหลจะเปนในแนวราบในชวงนี้และน้ําจะมาจากความหนาของชั้น aquifer ทั้งหมด 
หลังจากชวงแรกนี้ระดับน้ําใตดินเร่ิมที่จะลดลง น้ําจะไหลมาจากแรงโนมถวงของ aquifer และจะมี
การไหลทั้งในแนวนอนและแนวตั้ง ความสัมพันธของเวลากับระยะน้ําลดจะเปน function ของ
สัดสวนของคาความนําไฟฟาของแนวตั้ง-แนวนอน และระยะทางถึงบอสูบทดสอบ และความหนา
ของชั้น aquifer 

เม่ือเวลาผานไปอัตราของระยะน้ําลดจะลดลงและการกระจายของ particular annular 
region จนถึงทั่วๆหลุม discharge จะลดลง การไหลจะไหลในแนวนอนและกราฟขอมูลของ
ระยะเวลากับระยะน้ําลดจะเปนไปตาม Theis type curve กราฟ Theis จะสัมพันธกับคา 
storativity ความสัมพันธกับการไหลในแนวตั้งจะสงผลตอคาเฉล่ียของ drawdown ซึ่งจะสัมพันธ
กับขนาดของสัดสวน Sy/Ss เม่ือคาของ Ss เขาใกล 0 ชวงเวลาของ stage แรกของ drawdown จะ
เขาใกล 0 ดวยเม่ือคา Sy เขาใกล 0 ความยาวชวง stage แรกจะเพิ่มดังนั้น Sy = 0 aquifer จะ
ประพฤติตาม artersian ของ Ss Neuman ไดทําการแกสมการ 2 สวนคือ 

1. สําหรับเวลาที่เพิ่มหลังจากการ pumping ไดเร่ิมและน้ํามาจาก specific storage 
2. เม่ือเวลาผานไปสักระยะหนึ่งน้ํามาจาก gravity drainage กับ storativity = specific 

yield 
ใชสมการของ Neuman เม่ือ 
1. เปนชั้นไรแรงดัน (Unconfined aquifer) 
2. ชั้นไมอ่ิมตัวดวยน้ํา (vadose zone) ไมสงผลตอระยะน้ําลด (drawdown) 
3. สุดทายน้ํามาจาก storage เนื่องจาก gravity drainage ของชองรูพรุนที่เชื่อมตอกัน 
4. ระยะน้ําลด ไมสําคัญเม่ือเทียบกับความหนาของชั้นที่อ่ิมตัวดวยน้ํา (saturated 

aquifer) 
5. specific yield มากกวาหรือเทากับ 10 เทาของ elastic storage 
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        (2.11) 
 

                (2.12)  
 

           (2.13) 
 
       (2.14) 

 
โดยมี  h0-h  =  Drawdown (L; m or ft) 

Q  =  Constant pumping rate (L3/T; m3/d or ft3/d) 
T  = Transmissivity (L2/T; m2/d or ft2/d) 
r  =  Radial distance from the pumping well (L; m or ft) 
S   =  Storativity (Dimensionless) 
Sy  = Specific yield (Dimensionless) 
t  =  Time (T; d) 
Kh   =  Horizontal hydraulic conductivity (L/t; ft/d or m/d) 
Kv  =  Vertical hydraulic conductivity (L/t; ft/d or m/d) 

 b  = Initial saturated thickness of the aquifer (L; m or ft) 

หลักการวิเคราะหเคมีของน้ําบาดาล 

 
รูปท่ี 2.2 แผนภูมิไปเปอรไดอะแกรม 

ท่ีมา : Gollaway&Kaiser 198 
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ในการจําแนกรูปแบบทางเคมีของน้ําบาดาลจะใชแผนภูมิไปเปอร (Gollaway&Kaiser 
1980)โดยการตรวจวัดปริมาณแคทไอออนและแอนไอออนในน้ําตัวอยาง ไดแก                                                        

•  ไบคารบอเนต(Bicarbonate, HCO3-) 
•   คารบอเนต(Carbonate, CO3

2-) 
•   คลอไรด(Chloride, Cl-) 
•   ซัลเฟต(SO4

2-) 
•   แคลเซียม (Calcium, Ca2+) 
•  แมกนีเซียม (Magnesium, Mg2+) 
•  โซเดียม (Sodium, Na+) 
•  โพแทสเซียม (Potassium, K+) 

โดยคาที่ไดมาเร่ิมตนจะมีหนวยเปน mg/l แลวทําการเปล่ียนหนวยธาตุแตละธาตุเปน 
meg/l โดยนําคา mg/l มาคูณประจุไอออนแลวหารดวยมวลโมเลกุลจะไดหนวยเปน meg/l  ตอมา
หาเปอรเซนตของธาตุทั้งหมดโดยการคูณ 100 แลวหารดวยผลรวมทั้งหมดของ meg/l โดยคิดแยก 
Anion และ Cation คาที่นํามาพล็อตในสามเหล่ียมจะนําคาเปอรเซ็นตของธาตุทั้งหมดมาพล็อต ซึ่ง
ตองมีการตรวจสอบวาคาที่ไดสามารถที่จะใชไดหรือไมโดยนําเอาคาผลรวมของ Anion และ 
Cation มาลบกัน โดยตัวมากลบตัวนอยแลวหารดวยตัวนอยทั้งหมดคูณ 100 คาที่ไมเกิน 10% เปน
คาที่ใชได 

 
  
 
 
 
 
 
 
 
 

 
รูปท่ี 2.3 แผนภูมิไปเปอรไดอะแกรม 
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บทท่ี 3 
วิธีการดําเนินงานวิจัย 

3.1 วิธีดําเนินการศึกษาและวิจัย 
3.1.1 ศึกษางานวิจัยและขอมูลที่เกี่ยวของเพื่อนํามาประกอบในรายงานการวิจัย 

             3.1.2 รวบรวมขอมูลที่เกี่ยวของกับน้ําบาดาล ไดแก แผนที่ธรณีวิทยา แผนที่อุทก
ธรณีวิทยา แผนที่ภูมิประเทศ รวมถึงขอมูลอ่ืนๆไดแก แผนที่น้ําบาดาล ขอมูลสถานภาพบอน้ํา
บาดาลในพื้นที่ ขอมูลการสํารวจธรณีฟสิกสบนผิวดิน ขอมูลการเจาะบอสังเกตการณน้ําบาดาล 
ขอมูลสถานภาพบอ และขอมูลประกอบอ่ืนที่เกี่ยวของ  
 3.1.3 นําขอมูลการสูบทดสอบปริมาณน้ําในระยะยาว (72 ชั่วโมง) ในพื้นที่เพื่อหาสมบัติ
ทางชลศาสตรของชั้นหินในน้ําบาดาลอันไดแก คาสัมประสิทธิ์การจายน้ํา (Transmissivity, T) คา
สัมประสิทธิ์การยอมใหน้ําซึมผาน (Hydraulic conductivity) และคาสัมประสิทธิ์การกักเก็บ 
(Storativity, S)  

3.1.4 วิเคราะหและประมวลผลขอมูล                                                                                                          
   (1) จัดทําภาพตัดขวาง (Cross section) โดยการมานําขอมูลหลุมเจาะและขอมูล
ธรณีฟสิกสมาจัดทําภาพตัดขวาง (Cross section) และใชโปรแกรมคอมพิวเตอรเพื่อสราง Fence 
diagram และจัดทําแบบจําลองมโนทัศน  
  (2) วิเคราะหและประมวลผลขอมูลเพื่อหาสมบัติทางชลศาสตรของชั้นน้ําบาดาล
ตางๆ โดยใชขอมูลการสูบทดสอบปริมาณน้ํา 72 ชั่วโมง 
   (3) วิเคราะหและประมวลผลขอมูลเพื่อหาทิศทางการไหลของน้ําบาดาลในแตละ
ชั้นน้ําโดยใชขอมูลของระดับน้ําในบอตางๆ ที่เจาะและพัฒนาในแตละชั้นน้ํา 

(4) วิเคราะหและประมวลผลขอมูลวิเคราะหเคมีของน้ําบาดาล 
 3.1.5 จัดทําแบบจําลองเชิงมโนทัศนแสดงลักษณะชั้นน้ําบาดาลในพื้นที่และทิศทางการ
ไหลของน้ํา 
 3.1.6 อภิปราย สรุปผลขอมูลและจัดทํารายงาน 
3.2 การรวบรวมขอมูล 
 รวบรวมขอมูลที่เกี่ยวของกับน้ําบาดาล ไดแก แผนที่ธรณีวิทยา แผนที่อุทกธรณีวิทยา แผน
ที่ภูมิประเทศ และขอความอนุเคราะหขอมูลดานตางๆ จากกรมทรัพยากรน้ําและบริษัทจีเอ็มทีคอร
เปอเรชั่นจํากัดไดแก แผนที่น้ําบาดาล ขอมูลสถานภาพบอน้ําบาดาลในพื้นที่ ขอมูลการสํารวจธรณี
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ฟสิกสบนผิวดิน ขอมูลการเจาะบอสังเกตการณน้ําบาดาล ขอมูลสถานภาพบอ และขอมูลประกอบ
อ่ืนที่เกี่ยวของ ดังมีรายละเอียดดังตอไปนี้ 
  3.2.1 ขอมูลการสํารวจธรณีฟสิกสดวยวิธีการสํารวจแบบหยั่งลึก (vertical electrical 
resistivity sounding) โดยการจัดวางข้ัวไฟฟาแบบชลัมเบอรเจอร (Schlumberger 
Configuration) ทั้งหมด 30 จุด แสดงในรูปที่ 3.1 
 3.2.2 ขอมูลลักษณะชนิดของหินที่ระดับความลึกตาง  ๆ ที่ไดจากการเจาะบอสังเกตการณ
น้ําบาดาลแบบเก็บตัวอยางเศษหิน (Cutting) หรือขอมูลที่ไดจากตัวอยางแทงหิน (Core logging) 
พรอมผลวิเคราะหตัวอยางแทงหิน ทั้งหมด 69 บอ แสดงในรูปที่ 3.1 
 3.2.3 ขอมูลเกี่ยวกับชนิด ความลึกและความหนาของชั้นดินหิน จากการเจาะเก็บแทงหิน
ตัวอยางและการหยั่งธรณีฟสิกสในหลุมเจาะ (Bore hole logging) โดยประกอบไปดวย 
Resistivity logging, Spontaneous (Self) Potential logging (SP log) และNatural-Gamma 
loggingทั้งหมด 1 บอ แสดงในรูปที่ 3.1 

3.2.4 ขอมูลการสูบทดสอบปริมาณน้ําในระยะยาว (72 ชั่วโมง) โดยเปนขอมูลทีท่ําการสูบ
ทดสอบบอในบริเวณใกลเคียงกับพื้นที่ศึกษาทั้งหมด 2 บอคือสูบทดสอบในชั้นตะกอน 1 บอและ
สูบทดสอบในชั้นหินแข็ง 1 บอ แสดงในรูปที ่3.1 
 3.2.5 ขอมูลวิเคราะหเคมีของน้ําบาดาลในชั้นตะกอน 4 บอและชั้นหินแข็ง 2 บอ 

3.2.6 ขอมูลระดับน้ําในชั้นตะกอนและชั้นหินแข็ง ซึ่งขอมูลระดับน้ําในชั้นตะกอนมีทั้งหมด 
13 บอ และขอมูลระดับน้ําในชั้นหินแข็งมีทั้งหมด 20 บอ แสดงในรูปที่ 3.1 
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คําอธิบาย 
     ขอมูลช้ันดินช้ันหิน 
 
 

ขอมูลระดับน้ําในช้ันตะกอน 
 
 

ขอมูลระดับน้ําในช้ันหินแข็ง 
 
 

ขอมูลการสูบทดสอบปริมาณน้ํา 
 

ขอมูลการหยั่งธรณีฟสิกสใน
หลุมเจาะ 

 

ขอมูลธรณีฟสิกส 
 จังหวัด 

 

อําเภอ 
 

พื้นท่ีสํารวจศึกษา 
 

ขอบเขตอําเภอ 
 

ขอบเขตจังหวัด 

รูปท่ี 3.1 แผนที่แสดงบริเวณพื้นที่ศึกษาและตําแหนงบอน้ําบาดาลที่มีขอมูลชั้นดินชั้นหิน ขอมูลระดับน้ําในชั้นตะกอน หินแข็ง ขอมูลการสูบทดสอบปริมาณน้ํา ขอมูลธรณีฟสิกส 
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3.3 การวิเคราะหขอมูล 
 3.3.1 วิเคราะหขอมูลการสํารวจธรณีฟสิกสดวยวิธีการสํารวจแบบหยั่งลึก ขอมูลเกี่ยวกับ
ชั้นดินหินที่ระดับความลึกตางๆและขอมูลการหยั่งธรณีฟสิกสในหลุมเจาะเพื่อนํามาจัดทํา
ภาพตัดขวาง 5 แนว ดวยกันคือแนว NW-SE 3 แนวและแนว NE-SW 2 แนว โดยเปนการทํา
ภาพตัดขวางครอบคลุมทั้งพื้นที่ศึกษาเพื่อจําแนกหนวยหินทางอุทกธรณีวิทยาตางๆ ออกจากกัน
และนําขอมูลไปวิเคราะหหาชั้นหินที่สามารถใหน้ําได โดยใชโปรแกรม Microsoft Visio ในการ
จัดทําภาพตัดขวาง  
 3.3.2 วิเคราะหขอมูลการสูบทดสอบปริมาณน้ําในระยะยาว (72 ชั่วโมง) โดยเปนขอมูลที่
ทําการสูบทดสอบบอในบริเวณใกลเคียงกับพื้นที่ศึกษาทั้งหมด 2 บอคือสูบทดสอบในชั้นตะกอน 1 
บอและสูบทดสอบในชั้นหินแข็ง 1 บอ เพื่อนํามาหาสมบัติทางชลศาสตรของชั้นหินในน้ําบาดาลอัน
ไดแก คาสัมประสิทธิ์การจายน้ํา (Transmissivity, T) คาสัมประสิทธิ์การยอมใหน้ําซึมผาน 
(Hydraulic conductivity) และคาสัมประสิทธิ์การกักเก็บ (Storativity, S) โดยนําขอมูลการสูบ
ทดสอบปริมาณน้ํามาคํานวณในโปรแกรม Aquifer Test เพื่อหาวิธีที่จะไดขอมูลที่ใกลเคียงกับ
ความเปนจริงมากที่สุด 

3.3.3 ทําการวิเคราะหขอมูลเคมีน้ําบาดาลในแตละบอมาจําแนกเปนผลวิเคราะหน้ํา
บาดาลของแตละชั้นหินอุมน้ําและนําแตละผลวิเคราะหน้ําบาดาลมาคํานวณหาคา Milliequivalent 
(meq./l) จากนั้นนําคา meq./l ของอิออนบวกและอิออนลบทุกตัว ไบคารบอเนต(Bicarbonate, 
HCO3-),คารบอเนต(Carbonate, CO3

2-), คลอไรด(Chloride, Cl-), ซัลเฟต(SO4
2-), แคลเซียม 

(Calcium, Ca2+), แมกนีเซียม (Magnesium, Mg2+), โซเดียม (Sodium, Na+) และโพแทสเซียม 
(Potassium, K+) มาพล็อตในไปเปอรไดอะแกรม (Gollaway&Kaiser 1980) เพื่อหาประเภทน้ํา
บาดาลตามคุณสมบัติทางอุทกเคมีโดยใชโปรแกรม Aquachem   

3.3.4 ทําการวิเคราะหหาระดับและทิศทางการไหลของน้ําบาดาลแตละชั้นโดยแบงเปนชั้น
ตะกอนและชั้นหินแข็ง โดยนําขอมูลระดับน้ําและขอมูลความสูงของบอจากระดับน้ําทะเลมา
พิจารณาซึ่งขอมูลตองอยูในชั้นใหน้ําเดียวกันและมีการตรวจวัดในเวลาใกลเคียงกัน โดยใช
โปรแกรม Surfur เพื่อนํามาจัดทําเปนแผนที่แสดงแสดงเสนชั้นระดับน้ําบาดาล (Groundwater 
level or piezometic level) และทิศทางการไหลของน้ําบาดาล โดยใชโปรแกรม Surfur 

3.3.5 นําขอมูลทั้งหมดขางตนมาจัดทําเปนแบบจําลองเชิงมโนทัศนเพื่อแสดงสภาพ
โดยรวมของพื้นที่ศึกษาเพื่ออธิบายลักษณะทางอุทกธรณีวิทยา สมบัติการกักเก็บน้ําของชั้นน้ํา
บาดาลและทิศทางการไหลของน้ําบาดาล  
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บทท่ี 4 
ผลและการแปลความหมายขอมูล 

นําขอมูลการสํารวจธรณีฟสิกสดวยวิธีการสํารวจแบบหยั่งลึก ขอมูลเกี่ยวกับชั้นดินหินที่
ระดับความลึกตางๆ ขอมูลการหยั่งธรณีฟสิกสในหลุมเจาะ ขอมูลการสูบทดสอบปริมาณน้ําใน
ระยะยาว (72 ชั่วโมง) ขอมูลเคมีของน้ํา และขอมูลระดับน้ําในชั้นตะกอนและชั้นหินแข็งมาแปลผล
การศึกษาเพื่อศึกษาลักษณะทางอุทกธรณีวิทยา สมบัติการกักเก็บน้ําของชั้นน้ําบาดาลและเพื่อ
สรางแบบจําลองเชิงมโนทัศน ของชั้นน้ําบาดาลในบริเวณอําเภอศรีราชาและอําเภอบางละมุง 
จังหวัดชลบุรี   
4.1 ผลและการแปลความหมายขอมูลธรณีฟสิกส 
 หินทุกชนิดมีคาการนําไฟฟาตางกัน (Conductivity) ทั้งนี้ข้ึนอยูกับองคประกอบและปจจัย
ตาง ๆ ที่มีอยูในเนื้อหิน เชน องคประกอบของแร คุณสมบัติทางกายภาพและทางเคมี ที่สําคัญคือ
คุณสมบัติของ ๆ เหลวที่แทรกตัวอยูในหินนั้น ๆ เชน หินทราย (SiO2) และหินปูน (CaCO3) มี
คุณสมบัติทางกายภาพคลายกันคือเปนของแข็ง แตคาการนําไฟฟาตางกัน เพราะมีคุณสมบัติตาม
ธรรมชาติของน้ําที่แทรกอยูภายในเนื้อหินและเนื้อแรแตละชนิดตางกัน หินที่มีคาการนําไฟฟาต่ําจะ
มีคาความตานทานไฟฟาสูง (resistivity) 
 หินทรายที่มีคาความตานทานไฟฟาสูงอาจเปนไดทั้งน้ําบาดาลจืดหรือเปนแหลงน้ํามันและ
กาซธรรมชาติ  สวนหินทรายที่มีคาความตานทานไฟฟาต่ําคือชั้นน้ํากรอยและเค็ม หินดินดานจะมี
คาความตานทานไฟฟาต่ําเนื่องจากไมมีน้ําโคลนไหลแทรก (invasion) เขาไปอยูในเนื้อของ
หินดินดาน คาความตานทานไฟฟาต่ําที่วัดไดในหินดินดานมีที่มาที่สําคัญอีกประการหนึ่งคือมี
น้ําเค็มแทรกอยูในเนื้อของหินดินดานตั้งแตเกิดการตกตะกอนจัดเปน connate water 

หินแข็งเนื้อแนนมักมีคาความตานทานไฟฟาสูงเพราะไมมีรูพรุนใหน้ําหรือของเหลวใด ๆ 
แทรกอยูเชน หินแกรนิต ควอรตไซต แอนไฮไดรต หินปูน ยิปซัม เชิรต ถานหิน ในทางกลับกันถาหิน
มีน้ํามันหรือกาซธรรมชาติแทรกเต็มอยูในรูพรุนจะใหคาความตานทานไฟฟาสูงเชนกัน ทั้งนี้เพราะ
น้ํามันและกาซธรรมชาติเปนองคประกอบของ Hydrocarbons ไมใชสารละลาย (Electrolytes) จึง
ไมนําไฟฟา โดยคาความตานทานไฟฟาที่ปรากฏในหินตางชนิดกันแสดงในรูปที่ 4.1 
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VERTICAL  ELECTRICAL  SOUNDING 
SCHLUMBERGER  CONFIGURATION 

Date    20 ม.ค.54    UTME     720834 
Location ต.บึง อ.ศรีราชา จ.ชลบุรี  UTMN     1448298 
Remark  RS_CB 50     Elevation 79 m 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปท่ี 4.1 ตัวอยางกราฟระหวางคาความตานทานไฟฟากับความลึก ณ จุดสํารวจที่ RS_CB 50 

 
 จากนั้นนํากราฟที่ไดมาใชโปรแกรม IPI2WIN เพื่อที่จะไดชวยในการแปลผลชนิดและความ
หนาชั้นดินหินในพื้นที่ศึกษาแสดงในรูปที่ 4.2 
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VERTICAL  ELECTRICAL  SOUNDING 
SCHLUMBERGER  CONFIGURATION 

จุดสํารวจท่ี RS_CB50 Location       ต.บึง อ.ศรีราชา จ.ชลบุรี 
Zone  47P  Easting         720834  Northing       1448298 
Line bearing N-S  การใชประโยชนท่ีดิน    ปาสัก 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปท่ี 4.2 การแปลผลชนิดและความหนาชั้นดินหิน 

 

ความลึก ความหนา ความตานทานไฟฟาจําเพาะจริง 
(เมตร) (เมตร) (โอหม-เมตร) 

ลักษณะของช้ันดิน -ช้ันหิน 

0-6.79 6.79 311 Top soil 
6.79-
29.3 

22.51 60   sand, gravel, clay and clayey 
gravel  

>29.3 Infinity 599 Hard rock 
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4.2 ผลและการแปลความหมายขอมูลหลุมเจาะบอบาดาล 
 จากขอมูลเกี่ยวกับชั้นดินหินที่ระดับความลึกตาง  ๆ ที่ไดจากการเจาะบอสังเกตการณน้ํา
บาดาลแบบเก็บตัวอยางเศษหิน (Cutting) ขอมูลที่ไดจากตัวอยางแทงหิน (Core logging) และ
ขอมูลเกี่ยวกับชนิด ความลึกและความหนาของชั้นดินหินจากการเจาะเก็บแทงหินตัวอยางและการ
หยั่งธรณีฟสิกสในหลุมเจาะ (Bore hole logging) โดยประกอบไปดวย Spontaneous (Self) 
Potential logging (SP log), Natural-Gamma logging และ Resistivity logging (รูปที่ 4.3 และ 
4.4)  

Spontaneous (Self) Potential logging (SP log) เปนการวัดคา SP ซึ่งวัดคาการ
เปล่ียนแปลงศักยไฟฟาที่เกิดข้ึนในหลุมเจาะอันเนื่องมาจากมีการไหลของกระแสไฟฟาผาน
ของเหลวที่ไมนําไฟฟาในหลุมเจาะ ซึ่งชั้นหินทรายจะมีคา SP ต่ํากวาชั้นหินดินดานและหินแกรนิต 

Natural-Gamma logging โดยการวัดความเขมขนของกัมมันตภาพรังสีแกมมาทีถู่กปลอย
ออกมาจากชั้นหินเองตามธรรมชาตซิึ่งโดยปกติแลวตนกําเนิดที่สําคัญจะไดแก ไอโซโทปของโปแต
สเซียม ยูเรเนียม และธอเรียม ซึ่งจะพบมากในแรดินเหนียวในชั้นหินดินดาน บริเวณที่มีกัมมันตรังสี
สูงก็จะบงบอกถึงจํานวนของ ปริมาณดินเหนียวในชั้นหินนั้น ๆ ในธรรมชาติแลว หินดินดาน 
หินแกรนิตจะมีกัมมันตภาพรังสีแกมมาสูง ในขณะที่หินทราย หินปูน โดโลไมตจะมีกัมมันตภาพรังสี
แกมมาตํ่า 

Resistivity log จะชวยในการบงบอกลักษณะของหินที่หลุมเจาะผานชวยบงบอกระหวาง
ชั้นนํ้าเค็มและนํ้าจืดออกจากกัน ในกรณีบอนํ้าบาดาลเกาจะสามารถชีบ้อกตําแหนงของทอกรุและ
ทอกรองได ในสวนของชั้น Shale จะอานคาไดต่ําที่สุดและทั้งถานและหินทรายก็สามารถอานคา
ความตานทานไดต่ําเชนเดียวกันสวนหินแข็งเชนหินแกรนิตเนื้อแนนมักมีคาความตานทานไฟฟาสูง 

โดยนําขอมูลตางๆ มาจําแนกชั้นหินอุมน้ําตามลักษณะของตะกอนและคุณสมบัติทางธรณี
ฟสิกสไดออกเปน 2 ชั้นน้ําหลักดังนี ้

 1.ชั้นหินใหน้ําตะกอนเศษหินเชิงเขา (Colluvium Aquifers, Qcl) หรือชั้นตะกอนวางตัวอยู
ดานบนสุดประกอบดวยทราย ดินเหนียว กรวด ไมมีการแบงแยกตะกอนเปนชั้นๆเหมือนกับตะกอน
น้ําพาเพราะชองวางระหวางเม็ดตะกอนมักจะถูกอุดตันดวยชั้นดินเหนียวตกตะกอนทับอยูดวยกัน 
มีระดับความลึกของชั้นน้ําบาดาลประมาณ 10-40 เมตร 
 2. ชั้นหินแข็งของหินแกรนิต (Granite Aquifers) วางตัวอยูชั้นลางสุด มีระดับความลึกของ
ชั้นน้ําบาดาลประมาณ 40-80 เมตร 
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จากการแปลผลขอมูลการสํารวจธรณีฟสิกสดวยวิธีการสํารวจแบบหยั่งลึก ขอมูลเกี่ยวกับ
ชั้นดินหินที่ระดับความลึกตางๆและขอมูลการหยั่งธรณีฟสิกสในหลุมเจาะแลวนํามาจัดทํา
ภาพตัดขวาง 5 แนว ดวยกันคือแนว NW-SE 3 แนวและแนว NE-SW 2 แนว โดยเปนการทํา 
ภาพตัดขวางครอบคลุมทั้งพื้นที่ศึกษาโดยใชโปรแกรม Microsoft Visio ในการจัดทําภาพตัดขวาง
ซึ่งแตละแนวแสดงผลในรูปที่ 4.5-4.10  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



   

 

26 
 

WELL A03 Spontaneous (Self) Potential logging (SP log) 
Location:  วัดจุกกระเฌอ ต.บึง อ.ศรีราชา จ.ชลบุรี  UTME:  714579  UTMN:  1447459 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปท่ี 4.3 แสดงการแบงแยกชั้นหินอุมน้ําจากขอมูลการหยั่งธรณีฟสิกสในหลุมเจาะ Spontaneous 

(Self) Potential logging) 

หินทราย : ช้ันหินใหน้ําตะกอนเศษหิน
เชิงเขา (Colluvium Aquifers, Qcl) 

หินทราย : ชั้นหินใหน้ําตะกอนเศษหิน
เชิงเขา (Colluvium Aquifers, Qcl) 

หินแกรนิต : ชั้นหินแข็งของหินแกรนิต 
(Granite Aquifers) 

          20 

          40 
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WELL A03 Natural-Gamma logging และ Resistivity logging  
Location:  วัดจุกกระเฌอ ต.บึง อ.ศรีราชา จ.ชลบุรี  UTME:  714579  UTMN:  1447459 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.4 แสดงการแบงแยกชั้นน้ําจากขอมูลการหยั่งธรณีฟสิกสในหลุมเจาะ Natural-Gamma 
logging และ Resistivity logging 

หินทราย : ชั้นหินใหน้ําตะกอนเศษหินเชิง
เขา (Colluvium Aquifers, Qcl) 

หินแกรนติ : ชั้นหินแข็งของ
หินแกรนิต (Granite Aquifers) 
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คําอธิบาย 
     ขอมูลช้ันดินช้ันหิน 
 
 

ขอมูลระดับน้ําในช้ันตะกอน 
 
 

ขอมูลระดับน้ําในช้ันหินแข็ง 
 
 

ขอมูลการสูบทดสอบปริมาณน้ํา 
 

ขอมูลการหยั่งธรณีฟสิกสใน
หลุมเจาะ 

 

ขอมูลธรณีฟสิกส 
 จังหวัด 

 

อําเภอ 
 

พื้นท่ีสํารวจศึกษา 
 

ขอบเขตอําเภอ 
 

ขอบเขตจังหวัด 

รูปท่ี 4.5 แผนที่แสดงบริเวณพื้นที่ศึกษาและตําแหนงบอน้ําบาดาลที่มีขอมูลชั้นดินชั้นหิน ขอมูลระดับน้ําในชั้นตะกอน หินแข็ง ขอมูลการสูบทดสอบปริมาณน้ํา ขอมูลธรณีฟสิกส 

A 

B 

C 

D 

E 

F 

G 

H 

I 

J 
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รูปท่ี 4.6 ภาพตัดขวางแสดงการจําแนกชั้นหินอุมน้ําแนว NW-SE 
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รูปท่ี 4.7 ภาพตัดขวางแสดงการจําแนกชั้นหินอุมน้ําแนว NW-SE 
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รูปท่ี 4.8 ภาพตัดขวางแสดงการจําแนกชั้นหินอุมน้ําแนว NW-SE 
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รูปท่ี 4.9 ภาพตัดขวางแสดงการจําแนกชัน้หินอุมน้ําแนว NE-SW 
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 ขอมูลธรณีฟสิกสในหลุมเจาะ 
รูปท่ี 4.10 ภาพตัดขวางแสดงการจําแนกชั้นหินอุมน้ําแนว NE-SW 
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4.3 ผลและการแปลความหมายขอมูลสูบทดสอบปริมาณนํ้า 
 ในการวิเคราะหขอมูลการสูบทดสอบปริมาณน้ําในระยะยาว (72 ชั่วโมง) โดยเปนขอมูลที่
ทําการสูบทดสอบบอในบริเวณใกลเคียงกับพื้นที่ศึกษาทั้งหมด 2 บอคือสูบทดสอบในชั้นตะกอน 1 
บอและสูบทดสอบในชั้นหินแข็ง 1 บอ เพื่อนํามาหาสมบัติทางชลศาสตรของชั้นหินในน้ําบาดาลอัน
ไดแก คาสัมประสิทธิ์การจายน้ํา (Transmissivity, T) คาสัมประสิทธิ์การยอมใหน้ําซึมผาน 
(Hydraulic conductivity, K) และคาสัมประสิทธิ์การกักเก็บ (Storativity, S) โดยนําขอมูลการสูบ
ทดสอบปริมาณน้ํามาคํานวณในโปรแกรม Aquifer Test เพื่อหาวิธีที่จะไดขอมูลที่ใกลเคียงกับ
ความเปนจริงมากที่สุด โดยชั้นตะกอนรวน (Unconfined Aquifer) จะเลือกใชวิธีของ Neuman’s 
Method สวนชั้นหินแข็ง (Confined Aquifer) จะเลือกใชวิธี Theis Method, Cooper&Jacob 
Method และ Huntush’s Method โดยการที่ชั้นหินแข็งใช 3 วิธีเพื่อเปนการเปรียบเทียบคาตางๆ 
 โปรแกรม Aquifer Test จะเปนการนําเขาขอมูลเวลา-นาทีตั้งแตเร่ิมสูบ ระดับน้ําเร่ิมตน 
ระดับน้ําตั้งแตเร่ิมสูบจนถึงหยุดสูบ ความลึกบอ ระยะชั้นหินใหน้ํา อัตราการสูบน้ํา และขอมูล
ระยะหางระหวางบอสูบถึงบอสังเกตการณ โดยทุกขอมูลเปนขอมูลของบอสูบทดสอบ  

บอ NBV-MW-CB-004  

 
 
 

รูปท่ี 4.11 กราฟแสดงการพล็อตในชั้นตะกอน (Unconfined Aquifer)                                                 
โดยวิธี Neuman’s Method ของบอ NBV-MWU-CB-004 
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รูปท่ี 4.12 กราฟแสดงการพล็อตในชั้นหินแข็ง (Confined Aquifer)                                                       
โดยวิธี Theis Method ของบอ NBV-MWC-CB-004 

 

 
รูปท่ี 4.13 กราฟแสดงการพล็อตในชั้นหินแข็ง (confined aquifer)                                                            

โดยวิธี Cooper&Jacob Method ของบอ NBV-MWC-CB-004 
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รูปท่ี 4.14 กราฟแสดงการพล็อตในชั้นหินแข็ง (confined aquifer)                                                            
โดยวิธี Huntush’s Method ของบอ NBV-MWC-CB-004 
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บอ NBV-MW-CB-005  

 
 

รูปท่ี 4.15 กราฟแสดงการพล็อตในชั้นตะกอน (Unconfined Aquifer)                                                 
โดยวิธี Neuman’s Method ของบอ NBV-MWU-CB-005 

 

 
 

รูปท่ี 4.16 กราฟแสดงการพล็อตในชั้นหินแข็ง (Confined Aquifer)                                                       
โดยวิธี Theis Method ของบอ NBV-MWC-CB-005 
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รูปท่ี 4.17 กราฟแสดงการพล็อตในชั้นหินแข็ง (confined aquifer)                                                            
โดยวิธี Cooper&Jacob Method ของบอ NBV-MWC-CB-005 

 

 

 
 

รูปท่ี 4.18 กราฟแสดงการพล็อตในชั้นหินแข็ง (confined aquifer)                                                            
โดยวิธี Huntush’s Method ของบอ NBV-MWC-CB-005 

 



   

 

39 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ตารางท่ี 4.1 แสดงคาสมบัติทางชลศาสตรของชัน้หินใหน้ําบาดาลในชั้นตะกอนและชัน้หินแข็ง 
ดวยวิธีการคํานวณในแบบตางๆ 

 

หมายเลข
บอช้ันหิน

แข็ง 

 

ช่ัวโมง 

คา Transmissivity (T) (m2/d) คา Hydraulic Conductivity (K) (m/d) 

Thies Cooper-
Jacob 

Hantush Thies Cooper-
Jacob 

Hantush 

NBV-MWC-
CB-004 

72 1.270 1.250 1.080 0.159 0.157 0.135 

NBV-MWC-
CB-005 

72 1.170 1.080 0.200 0.074 0.068 0.013 

 

หมายเลขบอช้ัน
ตะกอน 

 

ช่ัวโมง 

คา Transmissivity                            
(T) (m2/d) 

คา Hydraulic Conductivity 
(K) (m/d) 

 

NBV-MWU-CB-004 72 1.07 0.268 

NBV-MWU-CB-005 72 0.42 0.052 

Neuman 
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4.4 ผลและการแปลความหมายขอมูลวิเคราะหเคมีของนํ้าบาดาล 
ในการจําแนกรูปแบบทางเคมีของน้ําบาดาลจะใชแผนภูมิไปเปอร (Gollaway&Kaiser, 1980)โดย
การตรวจวัดปริมาณแคทไอออนและแอนไอออนในน้ําตัวอยาง ไดแก                                                         

• ไบคารบอเนต (Bicarbonate, HCO3-) 
•   คารบอเนต (Carbonate, CO3

2-) 
•   คลอไรด (Chloride, Cl-) 
•   ซัลเฟต (SO4

2-) 
•   แคลเซียม (Calcium, Ca2+) 
•  แมกนีเซียม (Magnesium, Mg2+) 
•  โซเดียม (Sodium, Na+) 
•  โพแทสเซียม (Potassium, K+) 

 
รูปท่ี 4.19 แผนภูมิไปเปอรแสดงผลวิเคราะหเคมีของน้ําบาดาลในชั้นตะกอน 

ช้ันตะกอน บอ NBV-MW-U-CB-003 
 
 

บอ NBV-MW-U-CB-004 
 
 

บอ NBV-MW-U-CB-014 
 
 

บอ NBV-MW-U-CB-020 
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รูปท่ี 4.20 แผนภูมิไปเปอรแสดงผลวิเคราะหเคมีของน้ําบาดาลในชั้นหินแข็ง 

ช้ันตะกอน 
เปนแคลเซียม ไบคารบอเนต(Ca-HCO3) และเปนแคลเซียม โซเดียม ไบคารบอเนต (Ca-

Na-HCO3) : น้ําบาดาลที่เกิดใหม มีอายุนอย เปนกรดออน  ๆและพบในบริเวณที่รับน้ําฝน 
  เปนโซเดียม ไบคารบอเนต คลอไรด (Na-HCO3-Cl) คุณภาพน้ําบาดาลมักเปนน้ําจืดเปน
สวนใหญ 
ช้ันหินแข็ง 

เปนแคลเซียม โซเดียม ไบคารบอเนต(Ca-Na-HCO3)  น้ําบาดาลที่เกิดใหม มีอายุนอย 
เปนกรดออนๆและพบในบริเวณที่รับน้ําฝน 
 
 
 

 
 

ช้ันหินแข็ง บอ NBV-MW-C-CB-003 
 

บอ NBV-MW-C-CB-004 
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4.5 ผลและการแปลความหมายขอมูลระดับนํ้าของบอบาดาล 
 นําขอมูลระดับน้ําและขอมูลความสูงของบอจากระดับน้ําทะเลมาพิจารณาเพื่อหาระดับ
และทิศทางการไหลของน้ําบาดาลแตละชั้นโดยแบงเปนชั้นตะกอนและชั้นหินแข็ง โดยขอมูลตองอยู
ในชั้นใหน้ําเดียวกันและมีการตรวจวัดในเวลาใกลเคียงกัน โดยใชโปรแกรม Surfur เพื่อนํามาจัดทํา
เปนแผนที่แสดงแสดงเสนชั้นระดับน้ําบาดาล (Groundwater level or piezometic level) และทิศ
ทางการไหลของน้ําบาดาล (Direction of groundwater flow)  
 ชั้นหินใหน้ําตะกอนเศษหินเชิงเขา (Colluvium Aquifers, Qcl) หรือชั้นตะกอนจะมีทิศ
ทางการไหลของน้ําสวนใหญจากทิศตะวันออกไปยังทิศตะวันตกเพื่อไหลลงสูทะเล โดยใชขอมูล
ระดับน้ําในตะกอนทั้งหมด 13 บอ ดังแสดงในรูป 4.21 

ชั้นหินแข็งของหินแกรนิต (Granite Aquifers) จะมีทิศทางการไหลของน้ําสวนใหญจากทิศ
ตะวันออกไปยังทิศตะวันตกเพื่อไหลลงสูทะเลเชนเดียวกับชั้นตะกอน โดยใชขอมูลระดับน้ําในชั้น
หินแข็งทั้งหมด 20 บอ ดังแสดงในรูป 4.22 

      รูปที่ 4.23 แสดงแบบจําลองเชิงแนวคิดของชั้นน้ําบาดาล (Conceptual Model) 2 มิติ 
และรูปที ่4.24 แสดงแบบจําลองเชิงแนวคิดของชั้นน้ําบาดาล (Conceptual Model) 3 มิติ โดยใช
โปรแกรม Rock Work
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รูปท่ี 4.21 แผนที่แสดงทิศทางการไหลของน้ําบาดาลในชั้นหินใหน้ําตะกอนเศษหินเชิงเขา (Colluvium Aquifers, Qcl) หรือชั้นตะกอน 
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รูปท่ี 4.22 แผนที่แสดงทิศทางการไหลของน้ําบาดาลในชั้นหินหินแข็งของหินแกรนิต (Granite Aquifers) 
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คําอธิบายสัญลักษณ 
              บอน้ําบาดาลช้ันหินแข็ง 
              ทิศทางการไหลของน้ําบาดาล 
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รูปท่ี 4.23 แบบจําลองเชิงแนวคิดของชั้นน้ําบาดาล (Conceptual Model) 2 มิติ 

CONCEPTUAL MODEL 
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รูปท่ี 4.24 แบบจําลองเชิงแนวคิดของชั้นน้ําบาดาล (Conceptual Model) 3 มิติ โดยใชโปรแกรม 

Rock Work ซึ่งทราย กรวด ดินเหนียวจะมีการแทรกสลับกันไมสามารถแบงแยกตะกอนเปนชั้นๆได
และจะมีแกรนิตอยูดานลางสุด 

 
 

 
 
 
 
 

 

ทราย 
 
ดินเหนียว 
 
กรวด 
 
แกรนิต 
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บทท่ี 5 
สรุปผล ปญหาและอุปสรรค ขอเสนอแนะ 

5.1 สรุปผล 
5.1.1 พืน้ที่ศึกษามี 2 ชั้นน้ําหลักคือ 
 ชั้นหินใหน้ําตะกอนเศษหินเชิงเขา (Colluvium Aquifers, Qcl) หรือชั้นตะกอนวางตัว

อยูดานบนสุดประกอบดวยทราย ดินเหนียว กรวด ไมมีการแบงแยกตะกอนเปนชั้นๆ
เหมือนกับตะกอนน้ําพาเพราะชองวางระหวางเม็ดตะกอนมักจะถูกอุดตันดวยชั้นดิน
เหนยีวตกตะกอนทับอยูดวยกัน  

 ชั้นหินแข็งของหินแกรนิต (Granite Aquifers) วางตัวอยูชั้นลางสุด 
5.1.2 ชั้นหินอุมน้ําในชั้นตะกอนและชั้นหินแข็งมีศักยภาพในการใหน้ําบาดาลมีคา

ใกลเคียงกันคือ                     
 ชั้นตะกอนจะมีคาสัมประสิทธิ์การจายน้ําตั้งแต 0.420 -1.070 m2/d  
       ชั้นหินแข็งจะมีคาสัมประสิทธิ์การจายน้ําตั้งแต 0.200 -1.270 m2/d  
 ชั้นตะกอนจะมีคาสัมประสิทธิ์การซึมผานของน้ําตั้งแต 0.052 -0.268 m/d  
       ชั้นหินแข็งจะมีคาสัมประสิทธิ์การซึมผานของน้ําตั้งแต 0.013 -0.159 m/d  
5.1.3 ขอมูลเคมีของน้ําบาดาล 
ชั้นตะกอน 
เปนแคลเซียม ไบคารบอเนต(Ca-HCO3) และเปนแคลเซียม โซเดียม ไบคารบอเนต(Ca-

Na-HCO3) : น้ําบาดาลที่เกิดใหม มีอายุนอย เปนกรดออนๆและพบในบริเวณที่รับน้ําฝน 
  เปนโซเดียม ไบคารบอเนต คลอไรด(Na-HCO3-Cl)คุณภาพน้ําบาดาลมักเปนน้ําจืดเปน
สวนใหญ 

ชั้นหินแข็ง 
เปนแคลเซียม โซเดียม ไบคารบอเนต(Ca-Na-HCO3) : น้ําบาดาลที่เกิดใหม มีอายุนอย 

เปนกรดออนๆและพบในบริเวณที่รับน้ําฝน 
5.1.4 จากแบบจําลองเชิงมโนทัศนของอุทกธรณีวิทยาชั้นหินอุมน้ําทั้งชั้นตะกอนและชั้น

หินแข็งมีทิศทางการไหลสวนใหญจากทิศตะวันออกไปยังทิศตะวันตก 
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5.2 ปญหาและอุปสรรค 
5.2.1 ขอมูลที่ไดมาจากหลายแหลงทําใหตองมีการปรับขอมูลใหมีความสอดคลองกัน 
5.2.2 การออกภาคสนามตองเดินทางพรอมกับทางบริษัทจีเอ็มทีคอรเปอเรชั่นเนื่องจาก

งบประมาณที่จํากัดสงผลใหเวลาในการออกภาคสนามตรงกับเวลาเรียน  
5.2.3 ในการไปออกภาคสนามเพื่อวัดระดับน้ําในบอน้ําบาดาลพบวาบอที่มีขอมูลสวน

ใหญไมสามารถเขาไปวัดระดับน้ําไดเนื่องจากบอเกิดความชํารุด บอเลิกใชงานไปแลวหรือบางบอ
ถูกอุดกลบ  

5.2.4 ในข้ันตอนการตัดภาพตัดขวางนั้นไมสามารถลากเสนเชื่อมตอแบงชั้นน้ําไดชัดเจน
เนื่องจากชั้นตะกอนซึ่งวางตัวอยูดานบนสุดประกอบดวยทราย ดินเหนียว กรวด ไมมีการแบงแยก
ตะกอนเปนชั้นๆเพราะชองวางระหวางเม็ดตะกอนมักจะถูกอุดตันดวยชั้นดินเหนียวตกตะกอนทับ
อยูดวยกัน จึงตองใชขอมูลเพิ่มเติมทั้งขอมูลการเจาะสํารวจและขอมูลธรณีฟสิกสมาพิจารณา  

5.2.5 การใชโปรแกรม Rock Work ซึ่งใชในการทําภาพตัดขวางของชั้นน้ําบาดาล ซึ่งภาพ
ที่แสดงออกมานั้นส่ือความหมายการวางตัวของชั้นหินไมชัดเจนเนื่องมาจากขอมูลที่ไดไมเพียงพอ 
ทําใหไดใชโปรแกรม Microsoft Visio ในการจัดทําภาพตัดขวางของชั้นน้ําบาดาล 
 5.2.6 การใชโปรแกรม Aquifer Test ตองเลือกใชวิธีที่เหมาะสมกับขอมูลที่ไดมาเพื่อที่คา
ของคาสัมประสิทธิ์การจายน้ํา (Transmissivity, T) คาสัมประสิทธิ์การยอมใหน้ําซึมผาน 
(Hydraulic conductivity) และคาสัมประสิทธิ์การกักเก็บ (Storativity, S) จะออกมาใกลเคียงกับ
คาความเปนจริงมากที่สุด 

5.2.7 การจัดทําแผนที่แสดงทิศทางการไหลของน้ําบาดาลในชั้นหินหินแข็งของหินแกรนิต
นั้นขอมูลของบอบาดาลในพื้นที่มีปริมาณไมเพียงพอจึงไดนําขอมูลของบอบาดาลที่อยูบริเวณ
ใกลเคียงกับพื้นที่ศึกษามาพิจารณาประกอบกันเพื่อที่จะไดเห็นทิศทางการไหลของน้ําบาดาล
โดยรวม 
5.3 ขอเสนอแนะ 
 การดําเนินงานวิจัยนี้ถือไดวาบรรลุตามวัตถุประสงคที่ไดคาดหวังไว ซึ่งงานวิจัยนี้สามารถ
ที่จะเปนแนวทางในการศึกษาลักษณะทางอุทกธรณีวิทยาและสมบัติการกักเก็บน้ําของชั้นน้ํา
บาดาลในพื้นที่อ่ืนตอไปและควรจะมีการศึกษาตอยอดเพื่อใหงานวิจัยมีความสมบูรณมากยิ่งข้ึน 
โดยควรจะมีขอมูลดังตอไปนี ้

5.3.1 ควรจะมีบอที่ทําการทําการสูบทดสอบน้ําในพื้นที่มากกวานี้เพื่อที่จะไดคาสมบัติทาง
ชลศาสตรของน้ําที่แมนยํามากยิ่งข้ึน 
 5.3.2 ควรศึกษาเพิ่มเติมในเร่ืองของสมดุลของแหลงน้ําบาดาล 
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วิธีการทํา Aquifer Test 
1. เลือกโปรแกรม Aquifer Test 2.5 
 
 
 
 
 
 
2. Select File menu and Preferences เพื่อใสที่อยูของผูจัดทําขอมูล Aquifer Test นี้ ซึ่งเดิม
เจาของ Software คือ Waterloo Hydrogeologic Inc. Canada เราตองเปล่ียน Address/printout 
header เปนกรมทรัพยากรน้ําบาดาลเสียกอน กรณีเปล่ียน Preference จะไดเฉพาะเคร่ืองคอม ฯ 
หรือ Software เทานั้น เม่ือมีการยายขอมูลไปคอมฯ ตัวอ่ืน กอนส่ังพิมพควรทําการ Set 
Preference ของ Aquifer Test ทุกคร้ัง สวนนี้จะแสดงในหัวกระดาษรายงานที่มุมซายแลว click 
OK 

 
 
 
 
ใสที่อยูตามดานลาง 
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3. Select File menu and New (a.) จะได new Aquifer Test form (b.) 
 (a.) 

 
 (b.) 
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4. Input data of pumping test. Select Pumping Test menu (a.) เลือกทั้ง Title Block (b) และ 
Units (c) ตามลําดับ 
 (a.) Pumping Test  

 
 
 (b.) Title Block 

 
 
  
 
 

หมายเลขบอ 
ชนิดเคร่ืองสูบ 
วันทําการสูบ 
ชื่อคนทํา 
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(c.) Units 

 
 
5. เลือก Data menu and Creat 

 
 
เลือกความสัมพันธ Water vs. Time แลวคลิก OK 
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ข้ันตอนลงรายละเอียดขอมูลบอ 

 
 

b (m) = ความลึกบอ – ระดับน้ํากอนสูบ 
 L (m) = ระยะชั้นหินใหน้ํา (ระยะทอกรอง หรือ ชวงที่เปดใหน้ําเขาบอ) 
 กรอกขอมูลครบแลวกด OK 
 
6. ตอไปเปนการนําขอมูล X-cell เขาโปรแกรม ใหปดหนาจอ Edit data กอน แลวไป copy ขอมูล
จาก file x-cell เร่ิมวินาทีที่หนึ่งถึงวินาทีสุดทาย (รวมชวงการคืนตัวของน้ําดวย) 
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เตรียมขอมูล X-cell ใหใชตาราง “เวลา-นาที ตั้งแตเร่ิมสูบ (t)” กับ “ระดับน้ํา (เมตร)” อางอิงจาก
แบบฟอรมการสูบทดสอบ แลว copy ทั้งสองคอลัมนมาชิดกัน พรอมทั้งขอมูลชอง เวลา-นาที 
ตั้งแตเร่ิมสูบทําการตอเนื่องเวลาระหวางชวงสูบกับชวงน้ําคืนตัวและชองระดับน้ําหักลบความสูง
ปากบอเรียบรอยแลว 

 
 
หลังจาก Copy แลว มาเขาโปรแกรม แลวเลือก Menu edit กด Paste (วาง) 
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ถัดมาเลือก Menu data แลวเลือก edit 

 
 

 
 
ขอมูลที่ปอนทาง X-cell เขาทางโปรแกรมแลวกด OK 
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7. แปลงขอมูลตัวเลขพล็อตเปนกราฟ เลือกเมนูภาพคลิกที่นี ่
 
 
 
 
 
 
 
 
 
 

 
ถามถึงหนวยอีกคร้ัง 

 
กราฟที่ไดเปนวิธีที่ไมตองการ 
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8.เตรียมใสขอมูลอัตราการสูบ เลือก 
  
 
 
เลือกความสัมพันธ Discharge vs. Time แลวคลิก OK 

 
 

 
 
กรอกเสร็จแลวคลิก OK 
 
 
 

หมายเลขบอ 
 
อัตราการสูบที่ได หนวย 
ลูกบาศกเมตรตอชั่วโมง 
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9. เม่ือกรอกขอมูลของบอทั้งหมดแลวตอไปเปนการเลือกวิธีการคํานวณเลือก Menu Method แลว 
Select 

 
 
การคํานวณหาคา Aquifer Test นั้นมีหลายวิธ ีไดแก Theis, Cooper & Jacob Time-Drawdown, 
Huntush และ Neuman 
 9.1 เลือก Theis แลวเลือก OK 

  
กราฟที่ได (วงกลมสีชมพ)ู มีทั้งแนวนอนและแนวตั้ง ซึ่งขอมูลแนวนอนมาจากชวงทําการสูบ
ทดสอบสวนขอมูลแนวตั้งมาจากชวงรอน้ําคืนตัว นั่นเปนขอมูลที่นําเขาตอนตนจาก X-cell ทั้งหมด 
โดยวิธี Theis ขอมูลที่ใชในการคํานวณคาตองการชวงทําการสูบทดสอบน้ําออกจากชั้นหินใหน้ํา
เทานั้น นั่นคือกราฟแนวนอนนั่นเอง 
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เราตองใสขอจํากัดของชวงขอมูลทีโ่ปรแกรมตองใชเพื่อขอมูลที่ถูกตองตามชนิดวิธีคํานวณตองการ 
เลือก Menu Method แลวคลิก Time Limits 

 
 
 
เลือก unit (min) และใสเวลาสุดทายที่ทําการสูบทดสอบ กรณีที่ทําการสูบหยุดที่ นาที 4320 แลว
คลิก OK 

 
 
กราฟที่ไดชวงขอมูลการสูบทดสอบและคา Transmissivity (T) ซึ่งยังขาดคา Storativity (S) และ 
Hydraulic conductivity (K) ที่ตองหาเพิ่ม 

 
เพื่อวางกราฟขอมูลใหทับกับกราฟมาตรฐานของ Theis เลือก 
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โดยโปรแกรมทําการทับกราฟอานคาแบบอัตโนมัติ บางกรณีกราฟขอมูลทับกราฟมาตรฐานไดคา 
error หรือเกินที่จะรับได ก็สามารถปรับคาดวยลูกศรที่แปนคียบอรดใหเหมาะสม 

 
 
ทําการหาคา Hydraulic Conductivity (K) 
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ขอมูลที่ไดเพิ่มคือคา Hydraulic Conductivity (K) 

 
 
 
 

ความหนาของชั้นหินใหน้ํา
หรือระยะทอกรองน้ําหรือ
ระยะที่เปดรับน้ํา 
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ทําการหาคา Storativity (S) 
ไปที่ Menu Data แลวเลือก List จะไดกรอก Datalist มาใหเลือก Water level vs. time แลว OK 
หรือคลิกที่แถวขอมูล (จากแถวขอมูลสีชมพูเปล่ียนเปนสีเขียว) ทําไดเหมือนกัน ซึ่งเราตองใชขอมูล
จาก Data Type นี้เพื่อหาคา S 
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จากขางตนจะไดคา T,K,S ครบแลว แตหนวยยังเปน เมตร/นาที ตองเปล่ียนหนวยใหเปนสากลที่
ยอมรับไดนั่นคือ เมตร/วัน โดยเปล่ียนที่ Menu Pumping Test แลวเลือก Units 

 
 

 
แลวคลิก OK 
 
ข้ันตอนการจัดเก็บ 

 
ไปที่ Menu File แลวเลือก Save As จัดเก็บใน Folder ที่เตรียมไว ควรมีชื่อวิธีกํากับตอทายเพื่อ
ปองกันการสับสน 
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ในวิธีอ่ืนๆจะมีการนําเขาขอมูลแบบเดียวกันดังนั้นเม่ือนําเขาขอมูลตามที่ไดกลาวมาขางตนแลวไป
ที่ Menu Method แลวเลือก Select และสามารถที่จะเลือกวิธีถัดไปไดเลย 
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วิธีการทํา Rock Work 
1. เปดโปรแกรม rock work แลวกรอกขอมูล Location โดยใส Name, Eating, Northing, 
Elevation, Total Depth 

 
 

2. กรอกขอมูลในสวนของ Stratigraphy โดยกรอกขอมูล Depth (ความลึก) และ Formation (ชนิด
หิน) 
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3. กรอกขอมูลใหครบทุกบอในพื้นที่ทั้ง Location และ Stratigraphy โดยเวลาจะเพิ่มขอมูลบอใหม
ใหกด 
 
 
 
 
 
 
 
สามารถที่จะเปล่ียนสัญลักษณชนิดของหินได โดย Click Stratigraphic Types 

 

Double Click ที่แตละสัญลักษณเพื่อเปล่ียนรูปแบบ 
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4. เม่ือกรอกขอมูลครบแลวใหกด  Scan All Boreholes 

 
 
5. หลังจากนั้นกด Stratigraphy -----> Structural Elevations -----> 3Dimensional -----> All 
Surfaces 
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6. จะปรากฏหนาตางนี้ข้ึนมา คลิก Process 

 
 
7. รอใหโปรแกรม run ขอมูลเสร็จ 
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8. เม่ือ run ขอมูลเสร็จแลวจะปรากฏหนาจอดังภาพ 

 
 
9. กดเคร่ืองหมายตามรูปเพื่อให Model ขยายข้ึน 

 
 
10. จะได Model 3 มิติออกมา และสามารถ click mouse ใหดูได 360 องศา 
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วิธีการใช Microsoft Office Visio 2007 
 โปรแกรมนี้เปนโปรแกรมที่อยูใน Microsoft Office 2007 ซึ่งโปรมนี้จะชวยสรางรูปภาพ
ออกมา ซึ่งในงานวิจัยนี้จะใชในการสรางภาพตัดขวางในรูปแบบ 2 มิติ โดยทําข้ันตอนดังตอไปนี้ 

1. วาดภาพตัดขวางในกระดาษกราฟแลวสแกนภาพลงไปในเคร่ืองคอมพิวเตอร 

2. เปดโปรแกรม Microsoft Office Visio 2007 และคลิก New เพื่อสรางงานใหม 

 
 
 
 

 
 
 

3. Click File> Page setup เพื่อกําหนดขนาดของกระดาษ 
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4. ใสภาพ cross-section ที่สแกนเขาไปโดย click Insert> Picture> From file…> 
เลือกไฟลที่ตองการ > Open. 

 
 
 
 
 
 
 

5. กําหนด scale ในโปรแกรมใหเทากับ cross section ที่วาด 
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6. วาดรูปตามภาพที่เราไดสแกนเขามาโดยใชเคร่ืองมือดังรูป 

 
 
 
 
 
 
 

7. เขียนขอความโดย click Insert> Text box> Type words. 
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8. การใชเสนและขอความเหมือนกบัใน Microsoft Office Word 2007 หรือ Microsoft 
Office PowerPoint 2007 

9. เม่ือทํางานเสร็จแลวใหลบภาพตนแบบออก และกด save file โดย Click File> Save 
as…> เลือก Folder และตั้งชื่อ File พรอมกับเลือกชนิด File 
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วิธีการทํา AquaChem 2011.1 
 AquaChem 2011.1 เปนโปรแกรมที่ใชวิเคราะหคุณภาพของน้ํา และสามารถใชสรางแผน
ที่ แผนภูมิไปเปอรไดอะแกรม ภาพตัดขวาง เปนตน โดยมีวิธีทําตอไปนี้ 
 เตรียมขอมูลคุณภาพน้ําใน Microsoft Office Excel ขอมูลควรประกอบไปดวยไอออน
พื้นฐานตาม Galloway and Kaiser (1980) ประกอบไปดวย Sodium ion (Na  ), Magnesium 
ion (Mg 2 ), Potassium ion (K  ), Chloride ion (Cl  ), Sulfate ion (SO 2

4 ), Nitrate ion 
(NO 

3 ), Bicarbonate (HCO 
3 ) and Carbonate (CO 2

3 ), ในหนวย milligram ตอ liter (mg/l).   
1. เปดโปรแกรม AquaChem 2011.1 จะปรากฏหนาตางOpen database แลว click 

Cancel. 
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2. Click File> New จะมีหนาตางงานใหมข้ึนมา > เลือก AquaChem (มาพรอมกับการลง
โปรแกรม)> เลือก Demo_Basic.aqc> click Save 

 

 

3. Click Database File>  Demo_Basic> click Template> browse Basic_ Template > 
OK 
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4. Click File> Import> Samples/Stations 

 
 
 
 
 
 
 
 

5. Click icon> browse ไฟลงานที่อยูใน Excel > Open 
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6. Match ขอมูลใหเขากับในโปรแกรม > Next> Next 

 
 
 
 
 
 
 
 

7. หนาตาง Import options จะปรากฏข้ึน > click Yes> Close 
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8. Click Plots> New> Piper 

 
 
 
 
 
 
 
 

9.  เปล่ียนขอมูลตามภาพ (ตามการศึกษาของ Galloway and Kaiser, 1980)> click Apply 
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10.  สามารถที่จะเปล่ียน font และ size,  legend ตามภาพ > click Apply 

 
 
 
 
 
 
 
 
 

11. จะได piper diagram> click File> Export> Image> Save 

 
 
 
 
 
 
 
 

 


	ปกภาษาไทย	
	ปกภาษาอังกฤษ
	หน้าอนุมัติ	
	บทคัดย่อภาษาไทย
	บทคัดย่อภาษาอังกฤษ	
	กิตติกรรมประกาศ
	สารบัญ
	บทที่ 1 บทนำ
	บทที่ 2 เอกสารงานวิจัยและทฤษฎีที่เกี่ยวข้อง
	บทที่ 3 วิธีการดำเนินงานวิจัย
	บทที่ 4 ผลและการแปลความหมายข้อมูล
	4.1 ผลและการแปลความหมายข้อมูลธรณีฟิสิกส์
	4.2 ผลและการแปลความหมายข้อมูลหลุมเจาะบ่อบาดาล
	4.3 ผลและการแปลความหมายข้อมูลสูบทดสอบปริมาณน้ำ
	4.4 ผลและการแปลความหมายข้อมูลวิเคราะห์เคมีของน้ำบาดาล
	4.5 ผลและการแปลความหมายข้อมูลระดับน้ำของบ่อบาดาล

	บทที่ 5 สรุปผล ปัญหาและอุปสรรค ข้อเสนอแนะ
	เอกสารอ้างอิง
	ภาคผนวก

